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4.1 Ovládacie možnosti programu Kpl . . . . . . . . . . . . . . . . . . . 71
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Primárnym ciel’om výskumu
nesmie byt’ viac faktorov, ale viac
faktov so strategickou hodnotou.

PAUL WEISS

Úvod

Pri spracovanı́ výsledkov meranı́ a pozorovanı́ sa široko použı́vajú metódy grafického
zobrazenia. Čı́selné údaje, ako výsledky meranı́ a pozorovanı́ prezentované v tabul’kovej
forme neumožňujú dostatočne názorne charakterizovat’ zákonitosti študovaných proce-
sov, preto je vhodné tabul’ku doplnit’ grafom (graf je vlastne vizuálna podoba údajov
v tabul’ke). Grafické znázornenie poskytuje názornejšiu predstavu o výsledkoch experi-
mentu, umožňuje lepšie pochopit’ fyzikálny zmysel študovaného procesu, zistit’ (odhalit’)
všeobecný charakter funkčnej závislosti premenných veličı́n a napokon stanovit’ prı́tom-
nost’ (existenciu) maxı́m alebo minı́m funkčnej závislosti.

Grafy taktiež umožňujú vel’mi názorne porovnávat’ experimentálne hodnoty s teoretickou
krivkou (závislost’ou). Z precı́zne vyhotoveného grafu nameranej závislosti dvoch veličı́n

http://people.tuke.sk/ladislav.sevcovic
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sa dajú s dostatočnou presnost’ou určit’ napr. charakteristiky funkcie. Môžeme určit’ po-
lohu už spomı́naných extrémov, inflexných bodov, pri lineárnej závislosti odčı́tat’ z grafu
smernicu krivky a pod. Na okraj spomenieme, že sú známe metódy na grafické derivova-
nie a kvadratúru (integrovanie). Výhoda grafických metód sa uplatnı́ predovšetkým pri
meraniach s neekvidištančnými hodnotami nezávisle premennej veličiny, pretože čı́selné
spracovanie výsledkov je pri takýchto meraniach zložitejšie (t’ažšie), ako pre ekvidištančné
merania, napriek tomu, grafické riešenie je vo všeobecnosti nepresnejšie. Spomı́nané po-
stupy a metódy však stratili na význame v súvislosti s rozvojom výpočtovej techniky a jej
aplikáciı́ v experimentálnej praxi.

Na kreslenie grafov a ilustráciı́ existujú komerčné programy, ktoré sú bohato vybavené
podprogramami na interpoláciu aj extrapoláciu, na fitovanie (nájdenie najlepšej aproximá-
cie) nameranej závislosti zvolenou triedou funkciı́, na optimalizáciu, obsahujú štatistické
spracovanie výsledkov, vyhladenie závislostı́, rôzne filtre a pod. V prostredı́ operačného
systému GNU/Linux je bohatý výber programov na spracovanie a analýzu dát, ktoré sú
na rozdiel od komerčného OS Windows šı́rené pod licenciou GPL (GNU General Public
License)1. Vymenujme niektoré matematicko-grafické programy:

• GNUPLOT,

• Gnumeric a Calc z kancelárskeho balı́ka OpenOffice sú plnohodnotnou náhradou
za komerčný program Excel z MS Office, d’alej sú to

1Projekt GNU bol založený na vybudovanie kompletného operačného systému, ktorého výsledky budú
vol’ne dostupné počı́tačovej verejnosti. Programy dostupné v rámci GNU sú chránené tzv. GNU General
Public License (GPL), ktorá na rozdiel od všetkých ostatných licenciı́ garantuje každému právo programy
slobodne použı́vat’a šı́rit’ d’alej.

http://people.tuke.sk/ladislav.sevcovic
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• Veusz,

• LabPlot,

• Grace (xmgrace),

• Scigraphica,

• Octave,

• PyLab,

• QtiPlot a napokon

• Kpl.

V tejto prı́ručke stručne opı́šeme použı́vanie posledných dvoch programov. Základom
programovania v prostredı́ programuPyLab a jeho použitiu na podobné účely je venovaná
prı́ručka M. Kaukiča (2006) a programu Octave prı́ručka J. Bušu (2006). Dôvody, ktoré
viedli k tomuto výberu sú nasledujúce:

1. Proces inštalácie a konfigurácie je vel’mi jednoduchý a zvládne ho aj bežný použı́-
vatel’výpočtovej techniky.

2. Oba programy majú prı́vetivé grafické prostredie, pod ktorým sa skrýva softvér
profesionálnej kvality.

3. ProgramQtiPlot je vydareným klonom populárneho komerčného programuOrigin,
ktorým môžete vykonat’ profesionálnu analýzu experimentálnych dát, nakreslit’ do
grafu zložité funkcie. Grafický výstup je vysokej kvality vhodný na d’alšie spraco-
vanie, napr. programom TEX.

http://people.tuke.sk/ladislav.sevcovic
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4. Program Kpl je z pohl’adu pomeru jednoduchosti ovládania k výkonnosti ojedinelý
vo svojej kategórii. Môžeme ho dopĺňat’ vlastnými knižnicami na fitovanie dát
a programovými skriptmi2 na vykresl’ovanie všakovakých funkciı́, ktoré sa napı́šu
a skompilujú v programovacom jazyku C. Vytvorené grafy môžeme exportovat’ do
rôznych formátov, okrem iného do Encapsulated Postscript (EPS).

5. Parametre fitovacı́ch (aproximačných) funkciı́, ktoré sme zı́skali po spracovanı́ refe-
renčných dát na testovanie matematických knižnı́c a algoritmov týmito programami
sú v dobrej zhode s hodnotami uverejnenými na internetovej stránke Národného
inštitútu štandardov a technológiı́ Spojených štátov amerických (NIST, 2006).

Tématický materiál spracovaný v prı́ručke je usporiadaný do piatich kapitol, pričom každá
sa sústred’uje na jednu tému.

V prvej kapitole uvádzame krátky súpis hlavných pojmov z oblasti neistôt merania.
Druhá kapitola, ktorá je spoločná pre tretiu a štvrtú, je venovaná základným numerickým
metódam na spracovanie experimentálnych dát. Čitatel’by v každom prı́pade mal vediet’,
čo a ako počı́tačovým programom analyzuje a aká je podstata metódy, ktorú použı́va. Pri
prvom čı́tanı́ prı́ručky je možné túto kapitolu preskočit’.

Tretia a štvrtá kapitola sú t’ažiskom prı́ručky, čitatel’ sa z nich dozvie, aké možnosti
jednotlivé programy poskytujú a ako ich rýchlo použit’ na spracovanie a vizualizáciu
nameraných dát, prı́padne zobrazenie funkciı́.

2Skripty sú ASCII (textové) súbory obsahujúce prı́kazy. Sú tiež známe pod názvom zdrojové
súbory (source files) alebo dávkové súbory (batch files). Ked’ skript spustı́te, prı́kazy sa vykonajú
(interpretujú) jeden za druhým počnúc od začiatku tak, akoby ste ich pı́sali samostatne priamo
v prı́kazovom riadku jeden za druhým. Ide o akúsi obdobu dávkových prı́kazov v OS MS DOS.

http://people.tuke.sk/ladislav.sevcovic
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V záverečnej piatej kapitole sa kratúčko venujeme základným pravidlám na tvorbu úhl’ad-
ného grafu.

Prı́ručka je určená všetkým, ktorı́ potrebujú rýchle zvládnut’ prácu s programom na spo-
l’ahlivé numerické spracovanie nameraných dát a ich kvalitnú grafickú prezentáciu do
publikáciı́, vysokoškolských kvalifikačných prác, konferenčných zbornı́kov, posterov a pod.

Ďakujem recenzentom Jaroslavovi Skřivánkovi a Jánovi Bušovi za starostlivé prečı́tanie
rukopisu a cenné prı́pomienky, ktoré prispeli k spresneniu niektorých formuláciı́ a ku skva-
litneniu tejto prı́ručky.3

Košice 2006 L. Ševčovič

3Elektronická verzia prı́ručky, doplnky a opravy sú prı́stupné na URL adresách http: // people.
tuke. sk/ ladislav. sevcovic/ a http: // people. tuke. sk/ jan. busa/ kega/ qtiplot . Prı́po-
mienky a návrhy, ktoré pomôžu vylepšit’ d’alšie vydanie prı́ručky, zasielajte na adresu: RNDr. Ladi-
slav Ševčovič (Ladislav. Sevcovic@ tuke. sk ), Katedra fyziky, FEI, Technická univerzita v Košiciach,
Park Komenského 2, 041 20 Košice.

http://people.tuke.sk/ladislav.sevcovic
http://people.tuke.sk/ladislav.sevcovic/
http://people.tuke.sk/ladislav.sevcovic/
http://people.tuke.sk/jan.busa/kega/qtiplot
Ladislav.Sevcovic@tuke.sk


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 11 z 101

Späť

Celá strana

Zatvoriť

Koniec

1. Základné pojmy a definı́cie
z oblasti neistôt meranı́

V súčasnosti sa v metrológii, pri fyzikálnych a technických meraniach postupne
prechádza na nové metódy vyjadrovania odchýlok. Doterajšie chyby meranı́ sú
v súlade s medzinárodnými predpismi ISO a IEC nahradzované neistotami mera-
ranı́. Za hlavný dokument je možné považovat’ predovšetkým smernicu, ktorá
bola vydaná pod názvom Guide to Expression of the Uncertainty of Measurement
(GUM) (ISO, Switzerland 1995) medzinárodnými metrologickými orgánmi v roku
1993, korigovaná a doplnená v roku 1995. Pre prı́rodovedcov bude iste zau-
jı́mavé navštı́vit’ WWW stránku Národného inštitútu štandardov a technoló-
giı́ Spojených štátov amerických (NIST, 2006) http://physics.nist.gov/cuu/
Uncertainty/basic.html, ktorá prináša základné informácie o neistotách a ich
vyjadrovanı́.

Uvádzame zoznam niektorých významných medzinárodných organizáciı́, ktoré
tento projekt podporujú:

• BIPM Bureau International des Poids et Mesures

• IEC International Electrotechnical Commission

• IFCC International Federation of Clinical Chemistry

• ISO International Organization for Standardization

• IUPAC International Union of Pure and Applied Chemistry

http://people.tuke.sk/ladislav.sevcovic
http://physics.nist.gov/cuu/Uncertainty/basic.html
http://physics.nist.gov/cuu/Uncertainty/basic.html
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• IUPAP International Union of Pure and Applied Physics

• OIML International Organization of Legal Metrology

Stručný slovnı́k pojmov

Chyba, máme tu ma mysli chybu meracieho prı́stroja, ktorá má svoj pôvod v kon-
štrukčnom usporiadanı́, v konečnom delenı́ stupnice meraných hodnôt a pod.
Základnými zdrojmi chýb sú:

• nedokonalost’ prı́strojov,

• stárnutie a opotrebenie prı́strojov, čı́m sa môžu menit’ ich charakteristiky
a parametre,

• chyby experimentátora,

• nepresné metódy vyhodnocovania meranı́,

• vplyv linearizácie, interpolácie a zaokrúhl’ovania,

• zlá kalibrácia, inštalácia alebo umiestnenie prı́strojov atd’.

Neistota merania (skrátene neistota) je parameter, ktorý súvisı́ s výsledkom mera-
nia a určujúci rozptyl hodnôt, ktorý môžeme ešte racionálne priradit’ k meranej
veličine. (Neistota je teda interval, v ktorom sa s určitost’ou, definovanou prav-
depodobnost’ou bude skutočná (pravá) hodnota nachádzat’.) Neistoty (z jednot-
livych zdrojov) môžeme vyhodnocovat’ dvoma základnými metódami:

http://people.tuke.sk/ladislav.sevcovic
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• štatistickými metódami z nameraných údajov, ktoré sa nazývajú neistoty
stanovené metódou A, skrátene ich voláme neistoty typu A,

• neistoty zı́skané iným spôsobom ako v predošlom prı́pade, ktoré sa nazý-
vajú neistoty stanovené metódou B, skrátene ich voláme neistoty typu B (napr.
výsledky zı́skané pri predchádzajúcich meraniach, špecifikácie od výrobcu
meracieho prı́stroja, údaje z certifikátov, kalibračných listov, neistoty refe-
renčných údajov a pod.).

Vhodným zlúčenı́m štandardných neistôt zo všetkých zdrojov zı́skame celkovú
(kombinovanú) štandardnú neistotu. Treba zdôraznit’, že nečlenı́me neistoty, ale
metódy ich vyhodnocovania na metódu A a metódu B. Neistoty určené oboma
metódami sú rovnocenné, pokial’ boli určené korektne.

Rozdelenie pravdepodobnosti je funkcia vyjadrujúca pravdepodobnost’, že náhodná
veličina nadobudne určitú hodnotu alebo hodnoty z istého intervalu.

Rozptyl je stredná hodota druhej mocniny odchýlky náhodnej veličiny od jej
strednej hodnoty.

Rozšı́rená neistota je veličina definujúca interval okolo výsledku merania, ktorý za-
hrňuje vel’kú čast’ rozdelenia pravdepodobnosti hodnôt, ktoré je môžné priradit’
k meranej veličine.

Smerodajná odchýlka je druhá odmocnina z rozptylu prı́slušného rozdelenia prav-
depodobnosti.

Štandardná neistota merania je neistota merania vyjadrená ako smerodajná od-
chýlka. Pojem štandardná neistota (v meranı́) a smerodajná odchýlka (odmocnina

http://people.tuke.sk/ladislav.sevcovic
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z disperzie resp. z rozptylu; charakterizuje presnost’ merania) znamenajú to isté.

Vstupný odhad je výsledok merania vypočı́taný z odhadov vstupných dát pomo-
cou funkcie modelu merania.

Výstupná veličina je veličina, ktorá pri vyhodnotenı́ merania predstavuje meranú
veličinu.

http://people.tuke.sk/ladislav.sevcovic
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Tvrdı́m len, že v každom štúdiu
prı́rody je len tol’ko vlastnej vedy,
kol’ko je v nej matematiky.

IMMANUEL KANT

2. Numerické metódy spracovania
výsledkov meranı́

Úlohy súvisiace s vyhodnotenı́m experimentálnych dát vo fyzikálnej a technickej
praxi sa vyznačujú týmito základnými vlastnost’ami:

(a) rozsah a objem spracovaných dát obyčajne nie je vel’ký,

(b) v dátach sa nachádzajú aj vybočujúce hodnoty merania a rôzne nehomoge-
nity,

(c) v dátach sa zvyčajne vyskytujú nelinearity, vzájomné väzby a pod., ktoré
treba identifikovat’ a opı́sat’,

(d) parametre modelov majú obyčajne definovaný fyzikálny význam,

(e) často narážame na istú neurčitost’ (nejasnost’, nepresnost’) pri výbere mo-
delu na opis dát.

http://people.tuke.sk/ladislav.sevcovic
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Pri projektovanı́ pokusu je experimentátor vedený snahou zı́skat’ z meranı́ čo
najviac fyzikálne zaujı́mavých informáciı́.4 Preto experiment obyčajne prebieha
za rôznych (kontrolovaných) podmienok. Zmenou istých veličı́n sledujeme ich
vplyv na iné veličiny. Vo väčšine prı́padov takto zı́skame závislost’, o ktorej pred-
pokladáme, že je spojitá funkčná závislost’ jednej veličiny od druhej veličiny.
Napr. teplotnú závislost’ odporu, závislost’ anódového prúdu magnetrónu od
indukcie magnetického pol’a, závislost’ intenzity jadrového žiarenia od hrúbky
absorbátora atd’. Nameranı́m závislosti veličı́n práca experimentátora nekončı́,
naopak, nasleduje najdôležitejšia úloha a to fyzikálne interpretovat’ výsledky meranı́.
Pod pojmom interpretácie budeme rozumiet’ odôvodnenie výsledkov. V podstate
ide o určenie prı́čin, ktoré spôsobujú daný výsledok. Experimentálna práca je takto
z formálneho hl’adiska „obrátenou“ úlohou k teoretickému postupu, ktorý z de-
finovaných podmienok (prı́čin) predpokladá závery (následky) a tento fakt treba
mat’na zreteli pri spracovávanı́ merania. V konkrétnych prı́padoch sa najčastejšie
stretneme s týmito situáciami:

• Fyzikálna interpretácia meranej závislosti nie je dobre prepracovaná, tzn.,
že v čase konania experimentu neexistuje teoretický model, ktorý by viac-

4Metóda pozorovania dáva cenné informácie o vonkajšı́ch javoch a vzt’ahoch (vel’kost’, tvar, časová ná-
slednost’ a pod.). Poznávaciu hodnotu však stráca vtedy, ked’ sa pýtame na charakter vzt’ahov alebo na
prı́činu javov. Hlbšie poznanie skutočnosti umožňuje experimentálna metóda, ktorej použitie znamená
ciel’avedomı́ zásah do pôvodného stavu zámernou zmenou, ktorá je exaktne sledovaná za účelom zı́skania
nových vedeckých faktov. Experimentálna metóda identifikácie zámerne vyvoláva zmeny v skúmaných ob-
jektoch a na to použı́va najrôznejšie techniky. Cavier tento rozdiel medzi pozorovatel’om a experimentátorom
vyjadril takto: „Pozorovatel’prı́rode načúva, experimentátor ju vypočúva.“ Dáta zı́skané experimentom sa
stanú odpoved’ou na experimentátorovu otázku len po ich logickom spracovanı́, ktoré najčastejšie pozostáva
z matematického vyhodnotenia a poznávania, zo zovšeobecnenia zistených faktov.
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menej úspešne predpovedal tvar funkčnej závislosti. Potom je možné zı́s-
kané závislosti interpretovat’ iba kvalitatı́vne, resp. v jednoduchých prı́pa-
doch vyslovit’ hypotézu (napr. o lineárnej, resp. inej závislosti).

• Teoretický model predpovedá očakávanú závislost’, napr. y= a + bx. Experi-
ment5 lineárnu závislost’ potvrdı́. Treba nájst’ „správne“ hodnoty paramet-
rov, napr. a, b, ktorým môžu odpovedat’ d’alšie dôležité informácie. Úlo-
hami tohto druhu sa zaoberá vyrovnávacı́ počet. V súčasnej dobe sa široko
využı́va metóda najmenšı́ch štvorcov.6 Za správne hodnoty sa považujú také
hodnoty parametrov, ktoré dávajú najmenšı́ súčet druhých mocnı́n odchýlok
medzi nameranými a teoreticky predpovedanými hodnotami. Uvedieme
hlavné črty metódy.

Majme nameranú funkčnú závislost’ fi = f (xi) v bodoch i = 1, 2, . . . , n. Teore-
tický model predpokladá závislost’ F = F(x, p∗1 , p∗2 , . . . , p∗k), kde p∗1 , p∗2 , . . . , p∗k
sú parametre, ktoré sa nedajú vypočı́tat’ v rámci tohto modelu (čı́m menej pa-
rametrov, tým je model hodnotnejšı́). Odchýlky teoretickej F a experimentálej
funkcie fi, vypočı́tané v nameraných bodoch, označı́me ηi

ηi = F(xi, p∗1 , p∗2 , . . . , p∗k)− fi. (1)

5Experiment môžeme rozdelit’ na časti, ktoré sú do istej miery samostatné, voláme ich pokusy.
6Metódu najmenšı́ch štvorcov, ako výpočtovú procedúru opı́sal Adrien-Marie Legendre r. 1805

v práci Nouvelles méthodes pour la détermination des orbites des comètes. On navrhol aj názov tejto
metódy. Prvý, kto spojil metódu najmenšı́ch štvorcov s teóriou pravdepodobnosti bol Carl Friedrich
Gauss r. 1809 v práci Theoria motus corporum coelestium in sectionibus conicus solem ambientium auctore,
C. F. G. 1809. Poznamenal, že túto metódu použil už roku 1795.

http://people.tuke.sk/ladislav.sevcovic


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 18 z 101

Späť

Celá strana

Zatvoriť

Koniec

Vzhl’adom na to, že považujeme kladné odchýlky za rovnako významné ako
záporné, uvažujeme druhú mocninu ηi.7 Ďalej označı́me

Φ =
n

∑
i=1

ηi
2. (2)

Úlohou je nájst’ také odhady p1, p2, . . . , pk parametrov p∗1 , p∗2 , . . . , p∗k , pre ktoré
funkcia Φ (označovaná tiež ako účelová alebo kriteriálna) nadobúda minimum.
Aby mala táto požiadavka zmysel, musı́ byt’ splnených niekol’ko, nie práve
samozrejmých predpokladov, o ktorých sa musı́me pred začatı́m experimentu
presvedčit’, pozri napr. (PETROVIČ A KOL., 1989, I., str. 74):

1. chyba nezávisle premennej xi je zanedbatel’ne malá vzhl’adom na
chybu závisle premennej fi,

2. chyba merania premennej fi je náhodná veličina z normálne roz-
deleného súboru, ktorý má nulovú strednú hodnotu a konštantný
rozptyl v celej oblasti merania.8

Nutnou podmienkou pre minimum je potom splnenie rovnice

∂Φ

∂p j
= 2

n

∑
i=1

ηi
∂ηi

∂pi
= 2

n

∑
i=1

ηi
∂F(xi, p1, . . . , pk)

∂p j
= 0 , j = 1, 2, . . . , k. (3)

7Všeobecne sa uvažuje nejaká párna funkcia, t. j. funkcia f (x) taká, že f (x) = f (−x). Druhej
mocnine sa dáva prednost’ pred absolútnou hodnotou, lebo je to hladká funkcia.

8Systematické chyby ovplyvňujú experiment v rovnakom zmysle, ale vo všeobecnosti všetky
merania rôznou hodnotou. Majú nenulovú strednú hodnotu a prejavujú určitú mieru vzájomnej
závislosti, t. j. sú korelované. Nedodržanie predpokladu náhodnosti a nezávislosti chýb i nenu-
lovosti ich stredných hodnôt znemožňuje použitie štatistických metód vyhodnotenia.
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Túto sústavu je možné explicitne riešit’ v niektorých špeciálnych prı́padoch. Vše-
obecne treba použı́vat’ vybrané numerické metódy (KAUKIČ, 2006; PIRČ A BUŠA,
2002). Preberieme si tie funkčné závislosti, ktoré budeme potrebovat’ pri vyhod-
nocovanı́ laboratórnych záznamov.

2.1. Lineárna závislost’ y= a+bx a y= ax

Podl’a vzt’ahu (3) máme dva parametre p1 = a, p2 =b

ηi = a + bxi − fi. (4)

Z rovnı́c (2) a (3) dostaneme sústavu dvoch lineárnych rovnı́c pre neznáme a a b,
ktoré môžme l’ahko vyriešit’. Riešenie zapı́šeme v tvare výhodnom na počı́tačové
spracovanie. Označı́me

s1 =
n
∑

i=1
xi, s2 =

n
∑

i=1
fi, s3 =

n
∑

i=1
x2

i ,

s4 =
n
∑

i=1
xi fi, s5 =

n
∑

i=1
f 2
i , ν=ns3 − s2

1.

Potom

a =
s2s3 − s1s4

ν
, b =

ns4 − s1s2

ν
. (5)

Dá sa ukázat’, že pre štandardné neistoty odhadnutých parametrov a a b platia
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tieto vzt’ahy:

σa = σ ab
f

√
s3

ν
, σb = σ ab

f

√
n
ν

. (6)

V experimentoch však nie vždy poznáme hodnotu štandardnej neistoty σf . Jej
hodnotu môžeme zı́skat’ len opakovanı́m merania. Pri jednom experimente však
máme nameraných n hodnôt f a ked’ sme všetky zmerali s rovnakou chybou,
môžemu ju odhadnút’ z rozdielov medzi nameranými bodmi a funkciou (1)
vzt’ahom9

σ ab
f =

√√√√√ n
∑

i=1
(a + bxi − fi)

2

n− 2
. (7)

Podobne pre závislost’ typu y = ax platia tieto vzt’ahy:

a =
s4

s3
, σ a

f =

√√√√√ n
∑

i=1
(axi − fi)

2

n− 1
, σa =

σ a
f√
s3

. (8)

9V menovateli vzt’ahu je hodnota n− 2 namiesto n z toho dôvodu, aby bol odhad nevychý-
lený. Ak máme namerané iba dva body priamka určená metódou najmenšı́ch štvorcov prechádza
presne cez ne a reziduálny súčet štvorcov je rovný nule, vzt’ah predstavuje výraz typu 0/0.
Musı́me mat’ teda namerané aspoň tri body, aby sme z rozptylu bodov okolo priamky odhadli
neistotu merania. Odhad je nevychýleny, ked’ stredná hodnota odhadu sa rovná jej skutočnej
hodnote (nezávisle od počtu meranı́).
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Odvodenie týchto vzt’ahov však presahuje rámec tejto práce a nie je ani jej cie-
l’om. Čitatel’ sa môže o metóde najmenšı́ch štvorcov podrobnejšie dočı́tat’ napr.
v prácach autorov (LYONS, 2001; KUDRACIK, 1999; SQUIRES, 2001; PETROVIČ A KOL.,
1989)

2.2. Polynomiálna závislost’

Parametrami sú koeficienty v polynóme k-teho stupňa

F = akxk + ak−1xk−1 + . . . + a1x + a0 =
k

∑
l=0

alxl ,

ηi =
k

∑
l=0

alxl
i − f (xi) ,

∂F(xi, ao, a1, . . . , ak)
∂a j

=
∂

∂a j

k

∑
l=0

alxl
i = x j

i

a podl’a rovnice (3) dostaneme sústavu rovnı́c

∂Φ

∂a j
= 2

n

∑
i=1

[
k

∑
l=0

alxl
i − f (xi)

]
x j

i = 0.
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Prehodenı́m poradia sumácie dostávame sústavu k + 1 rovnı́c pre k + 1 nezná-
mych a0, . . . , ak

k

∑
l=0

B jl al = y j, (9)

kde

B jl =
n

∑
i=1

xl+ j
i , y j =

n

∑
i=1

f (xi) x j
i .

Sústavu (9) je možné riešit’ napr. Gaussovou eliminačnou metódou. Pre k = 1 dostá-
vame lineárnu závislost’, pre ktorú je riešenie zhodné s rovnicou (5).

2.3. Exponenciálna závislost’

F = αeβx, p1 = α, p2 = β, ηi = αeβxi − f (xi)

a z rovnice (3) dostaneme

∂Φ

∂α
= 2

n

∑
i=1

[
αeβxi − f (xi)

]
eβxi = 0,

∂Φ

∂β
= 2

n

∑
i=1

α2xi e2βxi − 2 ∑
i

α f (xi) xi eβxi = 0,
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čo je sústava transcendentných rovnı́c a na ich riešenie treba zvolit’ približné
numerické metódy. Aby sme sa tomu vyhli, pozmenı́me úlohu a namiesto ex-
trému účelovej funkcie Φ budeme hl’adat’ extrém funkcie Φ(L), v ktorej namiesto
F vystupuje ln(F). Logaritmovanı́m F dostaneme

ln(F) = ln(α) + β x.

Ak označı́me a= ln(α), b=β, môžeme použit’ výsledky rovnice (5) pre lineárnu
závislost’.

Poznámka:
Ak použijeme metódu najmenšı́ch štvorcov na takto transformovanú nelineárnu
funkciu, hl’adané parametre nezodpovedajú minimálnemu súčtu štvorcov odchýlok
∑

n
i=1 [ln fi − ln F(xi)]

2, pretože transformácia do súradnı́c prirodzeného logaritmu
ovplyvňuje odchýlky rozdielne v rôznych oblastiach pozdĺž krivky a tiež rozdielne
ovplyvnı́ pozitı́vne a negatı́vne chyby v tých istých bodoch krivky; preto treba prob-
lém riešit’ ako sústavu nelineárnych rovnı́c. Podl’a Brunovskej (1990, str. 50) však
neexistuje všeobecné pravidlo pre nelineárne regresie, podl’a ktorého by bolo možné
dat’ prednost’ jednej účelovej funkcii pred druhou. Ak rozptyl údajov nie je vel’ký,
tento rozdiel nie je významný. Odhad cez transformáciu možno ešte zlepšit’ za-
vedenı́m štatistickej váhy wi =

(
σ2

ln F/σ2
f

)−1
i do účelovej funkcie (2), ktorá potom

nadobudne tvar ∑
n
i=1 wi [ln fi − ln F(xi)]

2 = min.

Záverom treba zdôraznit’, že funkcia F (tzv. modelová funkcia) musı́ byt’fyzikálne
opodstatnená. Ak sa predpokladá lineárna závislost’, nemá fyzikálne opodstat-
nenie vyrovnávat’ meranú závislost’ kvadratickou funkciou, i ked’ môžeme oča-
kávat’ „lepšiu“ zhodu v zmysle najmenšı́ch štvorcov. Aproximácia experimentál-
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nych dát inými fyzikálne neodôvodnenými funkciami má význam iba z hl’adiska
vhodnejšieho uchovania informácie o experimentálnych dátach a z hl’adiska nie-
ktorých numerických operáciı́, napr. interpolácie a extrapolácie.

2.4. χ2 test kvality fitovania

Pri opise metódy najmenšı́ch štvorcov sme mlčky obišli otázku vplyvu chýb
merania na charakter a parametre (koeficienty) určovanej analytickej závislosti.
Krátko sa zmienime o tom, akú novú informáciu môžeme zı́skat’, ked’ vezmeme
do úvahy štandardné (stredné kvadratické) chyby experimentálnych dát. Pred-
pokladajme, že máme k dispozı́ci n dvojı́c meraných hodnôt (xi, fi), pričom chyba
veličiny xi je zanedbatel’ne malá a chyba merania veličiny fi je známa, rovná saσf i.

Optimálny postup pre dáta s normálnou distribúciou šumu je taký, ktorý hl’adá
minimum kriteriálnej (účelovej) funkcie metódy najmenšı́ch štvorcov, t. j. váho-
vanej sumy štvorcov rezı́duı́ alebo aspoň prostej reziduálnej sumy

χ2 =
n

∑
i=1

(
ηi

σf i

)2

=
n

∑
i=1

(
F(xi, p1, . . . , pk)− fi

σf i

)2

, (10)

kde σf i je chyba merania veličiny f v bode i. Tento výraz sa volá funkcia χ kvadrát
(chı́ kvadrát, χ2) a metóda najmenšı́ch štvorcov, v ktorej sa aproximácia dát vy-
konáva so započı́tanı́m chýb meranı́ sa volá metóda χ kvadrát. Poznamenajme, že
χ2 je opät’ funkcia diskrétnej premennej a prı́spevok jednotlivých členov (rozdie-
lov teoretických a meraných dát) je tým významnejšı́, čı́m presnejšie (s menšou
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hodnotou σf i) je zmeraná hodnota fi. Je teda zrejmé, že ked’nepoznáme chyby fi,
nemôžeme vyslovit’ žiaden záver ohl’adne kvality fitovania.

Vo všetkých prı́padoch χ2 slúži, ako indikátor zhody medzi experimentálnymi
a očakávanými hodnotami nejakej premennej. Pri dobrej zhode bude χ2 stupňa
n, pri zlej zhode bude omnoho väčšie ako n. Kritérium môžeme použit’ len v tom
prı́pade, ked’ poznáme očakávané hodnoty a štandardnú chybu. Pozrime sa na
túto úlohu trochu podrobnejšie.

Pre jednoduchost’ budeme predpokladat’, že všetky merania sú zat’ažené rovna-
kými štandardnými chybami σf i. Potom σf i = σ f (pozri vzt’ah 7) a v menova-
tel’och sumy výrazu (10) bude vystupovat’ pre všetky merania rovnaké σ f . Po
derivovanı́ vzt’ahu (10) za účelom hl’adania koeficientov polynómu dostaneme
tú istú sústavu rovnı́c, ako v metóde najmenšı́ch štvorcov. Ked’že do sústavy
rovnı́c vstupujú tie isté experimentálne dáta, potom prirodzene zı́skame aj rov-
naké parametre (koeficienty). Je teda na mieste otázka, akú novú informáciu nám
dá použitie známych hodnôt σf , ktoré nie sú obsiahnuté vo vypočı́taných para-
metroch. Vzt’ah (10) má „väčšı́“ fyzikálny význam, ako vzt’ah (2), χ2 funkcia je
bezrozmerná veličina, ktorá sa, ako vidı́me, rovná sume štvorcov odchýlok expe-
rimentálnych bodov od teoretickej (optimálnej) krivky v násobkoch štandardnej
chyby σf i.

Podmienka „fitovatel’nosti“ dát je splnená, ked’ je počet k hl’adaných parametrov
rovný alebo menšı́ ako počet nameraných bodov n. Predpokladáme však, že
v mnohých prı́padoch je splnený taký scenár experimentu, v ktorom n � k.
Zdravý rozum nám hovorı́, že ked’ má byt’ fitovanie dobré, rozdiely ηi by mali
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splňat’ rovnicu

ηi = |yi − f (xi)| ≈ σf i. (11)

Je to len „hrubá“ indikácia, ale vždy je lepšia, ako letmý prelet očami „pozdĺž
krivky“.10 Ked’ naše kritérium (11) dosadı́me do rovnice (10) dostaneme

χ2 ≈ n. (12)

Čı́m viac parametrov bude mat’ modelová funkcia použitá na fitovanie, tým
tesnejšie bude fitovaná krivka sledovat’ namerané dáta. Fitovanie budeme teda
pokladat’ za dobré, ked’ k = n. Tento predpoklad nás vedie k tomu, aby sme
aj s prihliadnutı́m na požiadavku vyslovenú v úvode tejto časti, že modelová
funkcia F(xi, pk) je tým hodnotnejšia, čı́m má menej parametrov, prijali praktické
pravidlo pre dobrý výsledok fitovania v tvare

χ2 ≈ n− k, (13)

ktoré bude platit’ pre jednu sériu meranı́. Keby sme mohli zopakovat’ naše mera-
nia nekonečne mnoho ráz a po každej sérii vypočı́tat’χ2, potom by sa jej stredná
hodnota rovnala n− k.

Najčastejšie môžu nastat’ dva prı́pady:

(a) ked’bude χ2�n− k nemôžeme vybranú modelovú funkciu F(xi, pk) použit’
na fitovanie nakol’ko σf i sú pre ňu „prı́liš malé“,

10Garcia (2000) volá tento prı́stup eye-balling a Press (1992) chi-by-eye.
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(b) ked’χ2�n− k fitovanie pokladáme za vel’mi dobré, môžeme sa domnievat’,
že σf i sú pre danú modelovú funkciu „dostatočne vel’ké“.

Vzt’ah (13) môžeme previest’ na vhodnejšı́ tvar, ked’ zavedieme redukovanú hod-
notu χ2 (alebo χ2 na stupeň vol’nosti), pre ktorú platı́

χ̃ 2 =
χ2

n− k
. (14)

Ked’že podl’a (13) očakávame hodnotu n− k, má byt’ splnená rovnost’

χ̃ 2 = 1. (15)

Naše predchádzajúce kritériá (a) a (b) teda môžeme vyslovit’ v takomto znenı́
: ked’ zı́skame pre χ̃ 2 hodnotu rovnú rádovo jednotke alebo menej ako jedna,
potom nemáme dôvod pochybovat’ o našom modeli; ale ked’ je zı́skaný výsledok
ovel’a väčšı́ ako jedna, potom je nepravdepodobné, že náš model je správny.

Na rozdiel od predchádzajúceho prı́stupu môžeme použit’χ2 štatistiku s prihliad-
nutı́m na štatistické vlastnosti dát, ktoré budeme aproximovat’ danou krivkou.11

V krátkosti uvedieme základné myšlienky tohoto prı́stupu.

11Ako prı́klad nám môže poslúžit’ meranie elektrického výkonu na rezistore. Prúd I precha-
dzajúci rezistorom sa riadi normálnym rozdelenı́m, ale výkon P sa nemôže riadit’ normálnym
rozdelenı́m pretože normálne rozdelenie pripúšt’a výskyt akejkol’vek reálnej (teda aj zápornej)
hodnoty náhodnej premennej. Výkon elektrického prúdu musı́ mat’ také rozdelenie, v ktorom
platı́ f (x) = 0 pre x < 0. V tomto prı́pade ide o rozdelenie odvodené z rozdelenia χ2. Takéto
rozdelenie má veličina, ktorá je súčtom n kvadrátov nezávislých premenných so štandardným
normálnym rozdelenı́m.

http://people.tuke.sk/ladislav.sevcovic


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 28 z 101

Späť

Celá strana

Zatvoriť

Koniec

Ako sme to už spomenuli v úvode tejto časti, predpokladáme, že chyba mera-
nej premennej f je náhodná veličina z normálneho rozdelenia súboru. Za tohto
predpokladu sú aj jednotlivé ηi nezávislé s normálnym rozdelenı́m, s nulovou
strednou hodnotou a disperziou η2

i . Potom sa suma štvorcov zapı́saná v tvare (10)
riadi distribučným zákonom známym pod menom χ2 rozdelenie (rozdelenie chı́ na
druhú) s m stupňom vol’nosti. Pod stupňom vol’nosti rozumieme počet namera-
ných bodov n znı́žený o počet parametrov k (vol’ných koeficientov): m = n− k.12

Integrál typu

P
(
χ2 = χ2

0

)
=

∞∫
χ2

0

fm(x) dx, (16)

alebo jednoducho P
(
χ2), kde fm(χ2 = x) je hustota rozdelenia pravdepodobnosti

pre rôzne stupne vol’nosti, dovol’uje vypočı́tat’kritické χ2
0 pre úroveň P

(
χ2 = χ2

0
)
.

Tieto hodnoty sú často vo forme tabuliek súčast’ou prı́ručiek a učebnı́c štatistiky,
alebo sú dostupné ako súčast’ štatistického softvéru, napr. program R. Na objas-
nenie uvedieme prı́klad, ako použit’ tabul’ku P(χ2). Predpokladáme, že máme
súbor 20 meranı́. Experimentálne dáta zamýšl’ame interpretovat’ lineárnou závis-
lost’ou y = a + bx, pre ktorú vyčı́slime parametre a a b. V tomto prı́pade sa počet
stupňov vol’nosti rovná m = 20 − 2 = 18. Ďalej predpokladajme, že výpočtom
podl’a vzt’ahu (10) sme zı́skali hodnotu χ2 = 9. Z tabul’ky 1 pre P(χ2) zistı́me, že
pri m = 18 stupňoch vol’nosti je pravdepodobnost’ zı́skat’ χ2 = 9 rovná ∼ 95 %.

12Ked’ sa chyby meraných hodnôt fi neriadia normálnym rozdelenı́m, úloha sa stáva ešte
zložitejšou. Na jej riešenie sa použı́va metóda, ktorá sa volá Metóda najväčšej hodnovernosti.
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Odchýlka nameraných údajov od očakávanej lineárnej závislosti je v tomto prı́-
pade nepodstatná. Keby sme zı́skali výsledok χ2 =28, z tabul’ky zistı́me, že takúto
a väčšiu hodnotu môžeme očakávat’v asi 5 % prı́padov. Model lineárnej závislosti
nemusı́me zamietnut’, ale môžeme o ňom pochybovat’. Prirodzene za takýchto
okolnostı́ zopakujeme experiment, aby sme zı́skali nové dáta alebo použijeme
inú modelovú funkciu. V prı́pade, ked’ je χ2 = 42 (pravdepodobnost’ ≈ 0,1 %)
potvrdı́ sa, že preverovaná hypotéza je isto nesprávna (dané body nemôžeme
aproximovat’ lineárnou závislost’ou). Na podrobnejšie oboznámenie sa s danou
problematikou odporúčame čitatel’ovi špecializovanú literatúru, napr. (PRESS ET
AL., 1992; RIEČANOVÁ A KOL., 1987; ZVÁRA A ŠTĚPÁN, 2001).

Tabuľka 1: Niektoré kritické hodnoty rozdelenia χ2. Uvedené sú hodnoty pravdepodobnosti P
pre χ2 = χ2

P pri m stupňoch vol’nosti

P

m 0,99 0,98 0,95 0,9 0,05 0,001

4 0,3 0,4 0,7 1,1 9,5 18,5

5 0,6 0,8 1,1 1,6 11,1 20,5

6 0,9 1,1 1,6 2,2 12,6 22,5

7 1,2 1,6 2,2 2,8 14,1 24,3

8 1,6 2,0 2,7 3,5 15,5 26,1

pokračovanie tabul’ky na d’al’šej strane
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(pokračovanie tabul’ky z predošlej strany)

P

m 0,99 0,98 0,95 0,9 0,05 0,001

9 2,1 2,5 3,3 4,2 16,9 27,9

10 2,6 3,1 3,9 4,9 18,3 29,6

11 3,1 3,6 4,6 5,6 19,7 31,3

12 3,6 4,2 5,2 6,3 21,0 32,9

13 4,1 4,8 5,9 7,0 22,4 34,5

14 4,7 5,4 6,6 7,8 23,7 36,1

15 5,2 6,0 7,3 8,5 25,0 37,7

16 5,8 6,6 8,0 9,3 26,3 39,2

17 6,4 7,3 8,7 10,1 27,6 40,8

18 7,0 7,9 9,4 10,9 28,9 42,3

19 7,6 8,6 10,1 11,6 30,1 43,8

20 8,3 9,2 10,8 12,4 31,4 45,3

21 8,9 9,9 11,6 13,2 32,7 46,8

22 9,5 10,6 12,3 14,0 33,9 48,3

pokračovanie tabul’ky na d’al’šej strane
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(pokračovanie tabul’ky z predošlej strany)

P

m 0,99 0,98 0,95 0,9 0,05 0,001

23 10,2 11,3 13,1 14,8 35,2 49,7

24 10,9 12,0 13,8 15,7 36,4 51,2

2.5. Interpolácia a extrapolácia

Interpolácia

Meranı́m určı́me konečný počet hodnôt x1, x2, . . . , xn a im prislúchajúce f (x1),
f (x2), . . ., f (xn). Predpokladajme, že x1 < x2 < . . . < xn. Často nás zaujı́ma hod-
nota veličiny f pre argument x, ktorý sa nezhoduje so žiadnou z nameraných
hodnôt a ležı́ v intervale x1 < x < xn. Hodnotu funkcie f pre argument x odhad-
neme interpoláciou. Z formálneho hl’adiska experiment poskytuje informácie iba
o hodnotách funkcie v konečnom počte bodov a o hodnote funkcie v bode x,
kde sme meranie nevykonali, nemôžeme tvrdit’ nič, ak nemáme nejaké d’alšie
informácie. Tým, že cez body (x1, f1), (x2, f2), . . . , (xn, fn) „preložı́me krivku“,
nahradı́me konečné postupnosti (spojitou) funkciou. Cez namerané body môže
prechádzat’ vel’mi vel’a rôznych funkciı́. Ak z teórie poznáme funkciu, ktorá
má prechádzat’ cez namerané body, postupujeme podl’a predchádzajúcej kapi-
toly. V opačnom prı́pade môžeme funkčnú závislost’ medzi meranými bodmi
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nahradit’ jednoduchými funkciami, najčastejšie lineárnou, kvadratickou, zried-
kavejšie polynómom vyššieho stupňa. Hovorı́me o lineárnej, kvadratickej alebo
polynomiálnej interpolácii. Pri lineárnej interpolácii dostaneme „lomenú“ spojitú
funkciu, ktorá však nemá derivácie práve v meraných bodoch. Pri kvadratickej
interpolácii môžeme dostat’ „hladšiu“ krivku, pri kubickej interpolácii a po čas-
tiach kubickej interpolácii (napr. kubické splajny) môžeme dosiahnut’ spojitost’
derivácie atd’. Je zrejmé, že čı́m hustejšie budú body namerané, tým menej sa
budú lı́šit’ hodnoty zı́skané interpoláciou rôznymi funkciami.

Naznačı́me postup pri interpolácii polynómom. Predpokladajme, že cez k + 1
nameraných bodov prechádza polynóm k-teho stupňa, t. j., že platı́

f (xi) =
k

∑
j=0

a jx
j
i , i = 1, 2, . . . , k + 1. (17)

Dosadenı́m známych hodnôt xi a fi dostávame k + 1 lineárnych rovnı́c pre k + 1
neznámych a0, a1, . . . , ak. Vyriešenı́m sústavy týchto rovnı́c dostaneme koefi-
cienty a0, . . . , ak a môžeme vypočı́tat’ hodnotu funkcie f (x) v l’ubovol’nom bode,
ktorý ležı́ mimo bodov x1, . . . , xk+1

f (x) =
k

∑
j=0

a j xi, x ∈ (x1, xk),

pre k = 1 dostávame lineárnu interpoláciu, pre k = 2 kvadratickú, atd’. Samoz-
rejme, na výpočet koeficientov a0, a1, . . . , ak vyberieme tie experimentálne body,
ktoré ležia v najbližšom okolı́ bodu x. Počet meranı́ n je obvykle väčšı́ ako k.
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Na prvý pohl’ad by sa zdalo, že zvyšovanı́m stupňa polynómu k sa zvyšuje
aj presnost’ interpolácie. V skutočnosti merané veličiny xi a f (xi) sú zat’ažené
neistotami, ktoré sa zvýrazňujú pri výpočte vysokých mocnı́n hodnôt xi v (17).
Z tohto dôvodu sa vo väčšine prı́padov uspokojı́me s interpoláciou nı́zkeho rádu.

Poznámka:
Ked’ hodnoty f (x1), f (x2), f (x3), . . . f (xn) boli zı́skané experimentálne a sú zat’a-
žené určitými nezanedbatel’nými chybami, nie je spravidla vhodné metódu interpo-
lácie aplikovat’. Je dokázané, že za predpokladu normálneho rozdelenia chýb meranı́
s nulovou strednou hodnotou v každom uzlovom bode najhodnovernejšie výsledky
dosiahneme metódou najmenšı́ch štvorcov. Uvedené predpoklady sú zvyčajne pri
fyzikálnych alebo technických experimentoch splnené, preto je metóda najmenšı́ch
štvorcov najpoužı́vanejšou metódou aproximácie (vyhladenia šumu) experimentálne
zı́skaných dát.

Extrapolácia

Ak z meraného priebehu funkcie odhadujeme hodnotu f (x) v bode x, ktorý
ležı́ mimo intervalu nameraných hodnôt, hovorı́me o extrapolácii. Pri extrapolácii
môžeme použit’ numerické metódy ako pri interpolácii. Treba však mat’ vždy
na zreteli, že pri extrapolácii musı́me byt’ omnoho opatrnejšı́ ako pri interpolá-
cii, hlavne ak x je d’aleko od meraného intervalu. Pokial’ je možné, snažı́me sa
nahradit’ extrapoláciu interpoláciou, t. j. meranı́m obsiahnut’ čo najväčšı́ interval
hodnôt xi. Mimo meraného intervalu môžu mat’ podstatný vplyv nové fyzikálne
javy, ktoré sa neprejavia v meranom intervale. Napr. pri meranı́ teplotnej závis-
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losti elektrického odporu vodiča v intervale teplôt od 10 ◦C do 40 ◦C nameráme
lineárnu závislost’ a extrapolujeme ju do 100 ◦C, pričom dodatočným meranı́m
zistı́me, že vodič sa roztopil pri teplote 80 ◦C, takže extrapolácia nad 80 ◦C je
neprı́pustná.

Numerické metódy uvedené v tejto časti sú základnými metódami, ktoré si každý
experimentátor, skôr či neskôr bude nútený osvojit’ a začat’ použı́vat’. S rozvojom
výpočtovej techniky, programovacı́ch metód a aplikačného softvéru sa rýchlo
rozšı́rili do mnohých oblastı́ prı́rodných vied a techniky. V nasledujúcich dvoch
kapitolách čitatel’ovi predstavı́me dva programy, ktoré umožňujú l’ahké a flexi-
bilné použı́vanie uvedených metód na numerické spracovnie experimentálnych
dát a výsledky uložit’ do kvalitného grafického výstupu v elektronickej alebo
tlačenej podobe.
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3. Program QtiPlot

QtiPlot je výkonný programový balı́k, ktorý poskytuje ako jednoduché tak aj
vel’mi zložité nástroje na analýzu dát a na kreslenie grafov. V tejto učebnej po-
môcke sa budeme venovat’ opisu verzie QtiPlot 0.8.5 v prostredı́ OS GNU/Linux
distribúcie UBUNTU 6.06. Domovská internetová stránka programu je na URL ad-
resehttp://soft.proindependent.com/qtiplot.htmlodkial’sa dá program stiah-
nut’. Na prácu v QtiPlote existujú dva druhy okien (pracovných prostredı́):

• tabul’kové

• a grafické.

Tabul’kové okno zobrazuje dáta potrebné na tvorbu grafu. V grafickom okne je vyob-
razený graf. Podl’a toho, ktoré z okien je aktı́vne, tabul’kové alebo grafické, menı́
sa obsah hlavnej ponuky. V tejto kapitole opı́šeme obe hlavné ponuky a bude
uvedený jednoduchý prı́klad na tvorbu grafu. Vzhl’adom na rozsah možnostı́,
ktoré poskytuje QtiPlot, budeme sa venovat’ len tým funkciám a ponukám QtiP-
lotu, ktoré sú potrebné na numerické spracovanie experimentálnych dát a ich
grafickú prezentáciu.

3.1. Ovládacie možnosti programu QtiPlot

Otvorenie QtiPlotu sa dá uskutočnit’ troma spôsobmi:

• kliknutie na ikonu QtiPlot na pracovnej ploche,

http://people.tuke.sk/ladislav.sevcovic
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• Menu → Škola hrou → Mathematics → kliknutie na QtiPlot,

• z prı́kazového riadka X terminálu prı́kazom qtiplot.

Pri prvom čı́tanı́ tejto kapitoly môže čitatel’, ktorý sa chce rýchlo oboznámit’
s použı́vanı́m programu, čast’3.1 preskočit’ a pokračovat’ v čı́tanı́ čast’ou 3.2 na
strane 46.

Na obrazovke sa zobrazı́ tabul’kové okno s prı́slušnými ponukami a ovládacı́mi
prvkami (obrázok 1). ZatvorenieQtiPlotu sa vykoná cez záložku File a potomQuit
alebo stlačenı́m klávesov Ctrl + Q (prı́padne Alt + F4).

3.1.1. Menu tabul’kového okna

Po vyvolanı́ QtiPlotu sa na obrazovke zobrazı́ okno s menom projektu UNTIT-
LED (obrázok 1). Ako to vidiet’ na obrázku, ide o tabul’kové okno. Hlavné menu
obsahuje tieto položky:

File Edit View Plot Analysis Tools Window Help
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Obrázok 1: Tabul’kové okno programu QtiPlot

V d’alšom stručne opı́šeme tie položky, ktoré sú potrebné na základné zoznámenie
sa s možnost’ami QtiPlotu.

File

New vytvorenie nového projektu
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Open otvorenie súboru s prı́ponou .qti,
editácia už vytvoreného projektu

Recent Projects zoznam piatich naposledy otvorených
projektov

Open image file importovanie obrázku (jpg, bmp, gif, png a iné)
do QtiPlot projektu

Import image . . . importovanie obrázkového súboru a konver-
tovanie intenzity obr. do maticovej tabul’ky

Save Project uloženie dokumentu pod pôvodným menom
Save Project as uloženie dokumentu pod novým menom
Open Template otvorenie uloženej šablóny 2D grafu, 3D grafu,

tabul’ky a matice
Save as Template uloženie šablóny aktuálneho objektu
Print vytlačenie aktı́vneho grafu
Print All Plots vytlačenie všetkych grafov projektu
Export ASCII exportovanie ASCII dátového súboru z tabul’ky
Import ASCII importovanie súboru ASCII s prı́ponou .dat
Quit ukončenie práce s programom QtiPlot

Edit

Undo zrušı́ posledný vykonaný krok
Redo vráti posledný vykonaný krok
Cut selection vybratie vyznačenej oblasti
Copy selection skopı́rovanie vyznačenej oblasti
Paste selection vloženie skopı́rovanej oblasti
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Delete selection zmazanie vyznačenej časti dát (aj celého stĺp-
ca, ak je vyznačený)

Delete fit tables vymazanie obsahu tabul’ky s hodnotami na
vykreslenie fitovanej funkcie, zmizne aj graf
vytvorený z týchto dát

Clear log information vymazanie obsahu log súboru s informáciami
o výsledkoch fitovania

Plot

Line pospájanie bodov do jednej lomenej čiary
Scatter bodový graf
Line + Symbol čiarový graf s vyznačenými bodmi
Special Line/Symbol zvislé čiary alebo „schodı́ky“, splajnová čiara
Columns stĺpcový graf, zvislé stĺpce
Rows stĺpcový graf, ale stĺpce sú vodorovné
Area graf s vyfarbenou plochou pod čiarou grafu
Pie koláčový graf
Vectors XYXY vytvorenie vektorového grafu,

prvé dva stĺpce musia obsahovat’ hodnoty
začiatočných súradnı́c vektora a posledné dva
koncové súradnice vektora

Vectors XYAM vytvorenie vektorového grafu,
prvé dva stĺpce musia obsahovat’ hodnoty
začiatočných súradnı́c vektora a posledné dva
uhol (v radiánoch) a amplitúdu vektora

http://people.tuke.sk/ladislav.sevcovic


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 40 z 101

Späť

Celá strana

Zatvoriť

Koniec

Statistical Graphs štatistické grafy
Panel viac grafov v jednom okne
Plot 3D trojdimenzionálne grafy

Analysis

Statistics on Columns štatistické vyhodnotenie dát v stĺpci
Statistics on Rows štatistické vyhodnotenie dát v riadku
Sort Columns usporiadanie dát v stĺpci
Sort Table usporiadanie dát v celej tabul’ke
Normalize normalizovanie dát v stĺpci alebo vo všetkých

stĺpcoch tabul’ky
FFT . . . analýza dát v tabul’ke rýchlou Fourierovou

transformáciou
Correlate výpočet korelácie dát dvoch vybraných

stĺpcov tabul’ky
Convolute výpočet konvolúcie dát z dvoch vybraných

stĺpcov tabul’ky, prvý reprezentuje signál
a druhý funkciu

Deconvolute výpočet dekonvolúcie dát z dvoch vybraných
stĺpcov tabul’ky, prvý reprezentuje signál
a druhý funkciu

Non-linear Curve Fit nelineárna aproximácia dát vybraného stĺpca
tabul’ky (nesmú tvorit’ priamu úmernost’)
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Table

Set columns as nastavenie dát v stĺpci (X, Y, Z, nenastavené)
Column Option . . . nastavenie vlastnostı́ stĺpca (počet riadkov,

typ dát, formát čı́siel a pod.)
Set Column Value . . . matematické operácie s dátami v stĺpci
Fill Column with vyplnenie stĺpca tabul’ky vzostupnými

alebo náhodnými čı́slami
Add column pridanie nového stĺpca do tabul’ky
Columns . . . pridanie stĺpcov do tabul’ky,

nastavenie počtu stĺpcov v tabul’ke
Rows . . . pridanie riadkov do tabul’ky,

nastavenie počtu riadkov v tabul’ke
Convet to matrix konverzia dát v tabul’ke do maticového tvaru

Po konverzii tabul’ky do maticového tvaru v hlavnom menu pribudnú položky
3D a Matrix. V položke Matrix nájdeme prı́kazy na vytvorenie transponovanej
a inverznej matice, vypočet determinantu štvorcovej matice, úpravu dát vo vy-
tvorenej maticovej tabul’ke a konverziu maticovej tabul’ky na XY tabul’ku.

3.1.2. Menu grafického okna

Po vykreslenı́ grafu z tabul’kových dát sa zmenı́ hlavné menu a namiesto položiek
Plot a Table budú Graph a Format a pribudne ešte položka Data (obrázok 2).
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Obrázok 2: Grafické okno programu QtiPlot

V d’alšej časti uvedieme ponuky, ktoré budeme potrebovat’ na vytvorenie grafu
a numerickú analýzu dát.

Graph

Add/Remove Curve . . . pridanie/odobratie krivky do/z grafu
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Add Error Bars zobrazenie chyby nameraných dát úsečkami
Add Function . . . pridanie užı́vatel’om definovanej funkcie
New Legend pridanie legendy (obnovenie vymazanej)
Add Text pridanie l’ubovolného textu (po kliknutı́ na

graf sa otvorı́ okno na editovanie textu)
Draw Arrow/Line pridanie šı́pky alebo úsečky so šı́pkou
Add time stamp pridanie dátumu a času
Add Image pridanie obrázka (jpg, bmp, gif, png a iné)
Add Layer pridanie nového grafu do grafického okna
Remove Layer odobratie grafu z grafického okna
Arrange Layers úprava grafov (pı́smo, tituly, popis osı́, . . . )

Data

Disable tools zapnutie všeobecného kurzora
Zoom zapnutie lupy
Rescale to show all prekreslenie grafu do celého okna
Data reader kliknutı́m na bod sa otvorı́ okno

Data display a zobrazia sa súradnice
Select data range umožnı́ kurzorom myši alebo šı́pkami

klávesnice vybrat’ určitý rozsah dát
Screen reader čı́tač súradnı́c, otvorı́ okno Data display

a načı́ta súradnice hociktorej pozı́cie
v okne grafu

Move data Points . . . umožnı́ premiestnenie bodov grafu,
zmeny sa prejavia aj v tabul’ke
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Remove Bad Data Points . . . umožnı́ odstránenie bodov z grafu,
y-ové hodnoty bodov sa vymažú
z tabul’ky

Analysis

Translate prekladanie dát vo vodorovnom
a zvislom smere

Differentiate výpočet prvej derivácie z dát
Integrate numerický výpočet integrálu
Smooth „vyhladenie“ krivky metódou FFT filtra,

metódou pohyblivého priemeru
a Savitzkého-Golayovou metódou

FFT filter rôzne filtre (dolno a hornopriepustný,
pásmový priepustný a blokový)

Interpolate . . . interpolácia dát (lineárna, kubická
a Akimova)

FFT . . . inverzná a dopredná FFT
Fit Linear lineárna regresia
Fit Polynomial . . . polynomická regresia do 9. stupňa
Fit Exponential Decay regresia exponenciálnou tlmenou krivkou
Fit Exponential Growth . . . regresia exponenciálnou rastovou krivkou
Fit Boltzmann (Sigmoidal) regresia Boltzmannovou funkciou
Fit Gaussian regresia Gaussovou funkciou
Fit Lorentzian regresia Lorentzovou funkciou
Fit Multi-peak regresia na vyznačené maximá
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Gaussovou alebo Lorentzovou funkciou
Non-linear Curve Fit . . . nelineárna regresia Nelderovou-

-Meadovou simplexovou
a Levenbergovou-Marquardtovou
metódou, k dispozı́cii sú základné
matematické funkcie, sedem vsta-
vaných funkciı́ a je tu aj možnost’
definovat’ vlastné funkcie

Format

Plot . . . otvorı́ sa okno so záložkami s možnost’ami editovat’
rozsah, popis a formát osı́, formát mriežky a všeobecné
vlastnosti grafu

Curves . . . otvorı́ sa okno na editovanie grafických vlastnostı́ krivky
Scales . . . nastavenie rozsahu osı́
Axes . . . editovanie formátu osı́
Grid . . . editovanie formátu mriežky grafu
Title . . . editovanie názvu grafu
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3.2. Prı́klady použitia programu

3.2.1. Zadávanie a import dát do tabul’ky

Zadanie vlastných dát priamo do tabul’ky

Vo fyzikálnych, chemických a iných laboratóriách zı́skavame namerané hodnoty,
ktoré potrebujeme vyhodnotit’ napr. štatistickými metódami, vykonat’ regresnú
analýzu rôznymi funkciami a výsledky chceme znázornit’ ako čiary v grafoch.
Práve na grafické zobrazenie meranı́ a ich vyhodnotenie s výhodou môžeme
použit’QtiPlot.

Graf vo všeobecnosti chápeme ako grafické zobrazenie funkcie y = f (x), pričom
x je nezávisle a y závisle premenná veličina. V tabul’kovom okne (obrázok 1)
vkladáme do stĺpca 1[X] nezávisle premennú a do stĺpca 2[Y] a d’alšı́ch stĺpcov
3[Y], 4[Y] atd’. závisle premenné. Počet premenných definujeme podl’a našich
požiadaviek, v prı́pade potreby vytvárame d’alšie stĺpce prı́kazom Table → Add
column alebo pravým klikom myši v hlavičke tabul’ky vyberieme z kontextového
menu Add column.

Importovanie dátoveho súboru boxbod.dat

V úvode sme spomenuli, že funkcionalitu programu sme skúšali dátami z inter-
netovej stránky Národného inštitútu štandardov a technológiı́ Spojených štátov
amerických (NIST, 2006). Stiahli sme si dáta z kolekcie pre nelineárnu regresiu
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s názvom BoxBOD, ktoré sú zaradené do kategórie s vysokou náročnost’ou na
spracovanie.13 Tabul’ka bola uložená do dátového súboru s názvom boxbod.dat.
Tento súbor teraz importujeme, postupným vyvolanı́m nasledovných ponúk File
→ Import ASCII → Set import option, nastavı́me formát importovaných dát a po-
tom vykonáme import dát do tabul’ky, napr. z nástrojovej lišty kliknutı́m na ikonu

Vyhl’adáme súbor boxbod.dat, po vol’be sa údaje prenesú do tabul’ky, pozri ob-
rázok 3.

Obrázok 3: Tabul’kové okno s importova-
nými dátami

Obrázok 4: Tabul’kové okno s importova-
nými dátami, premenovaným prvým stĺp-
com a zmenou formátu dát

V prı́pade potreby môžeme premenovat’ nazvy stĺpcov tabul’ky. Klikneme 2× na
polı́čko 1[X], otvorı́ sa okno s názvom Column option, v ktorom môžeme zmenit’

13 http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml
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názov stĺpca, počet desatinných miest čı́selnej hodnoty premennej v stĺpci, šı́rku
stĺpca, názov premennej a iné parametre (obrázok 5). Výsledok úpravy vidı́me
na obrázku 4.

Obrázok 5: Možnosti formátovania tabul’kového okna
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3.2.2. Vytvorenie a úprava grafu

Kliknutı́m do hlavičky tabul’ky a t’ahom myši (alebo stlačenı́m klávesu Shift a sú-
časným pohybom klávesových šı́pok) vyznačı́me stĺpce závisle a nezávisle pre-
mennej a z hlavného menu zvolı́me Plot → Scatter. Vykreslia sa body do grafu
s názvom graph 1 (obrázok 6).

Obrázok 6: Zobrazenie dát tabul’ky z obrázku 3

Graf by sme mohli nazvat’ „suro-
vým“. V tomto grafe je zobrazená
legenda a v l’avom hornom rohu
grafického okna je okienko 1 . Po-
kial’ by sme nevyznačili v dátovej
tabul’ke nezávisle premennú, dvoj-
klikom na toto okienko sa otvorı́
dialógové okno Add/Remove cur-
ves, v ktorom je ponuka presunu-
tia údajov z okienka Available data
do okienka Graph contents a potom
kliknutı́m na položku Plot Associa-
tion . . . si môžeme vybrat’nezávisle
aj závisle premennú, ktoré chceme
zobrazit’ v grafe.

Pomenovanie osı́ vykonáme dvoj-
klikom na jednotlivé osi grafu alebo

z hlavného menu zvolı́me Format → Plot . . .→ Axis a prevedieme požadované
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úpravy. Dvojklikom do rámčeka s legendou v l’avom hornom rohu grafu sa otvorı́
okno na editovanie legendy. Ak je to potrebné urobı́me úpravy, zmeny sa prejavia
klikom na položku Apply. Ukončenie editácie potvrdı́me klikom na položku OK
alebo Cancel. „Surový“ graf má názov Title, jeho premenovanie môžeme urobit’
dvojklikom myši na tento názov alebo z hlavného menu zvolı́me Format → Title
. . . , otvorı́ sa okno na editovanie textu, napı́šeme nový názov a premenovanie po-
tvrdı́me klikom na položku Apply, pričom samozrejme môžeme použit’ aj pı́smo
s diakritikou, grécke pı́smená, symboly a pod., pozri obrázok 11.

Obrázok 7: Upravený graf z obrázku 6

Editáciu názvu ukončı́me klikom
na položku OK alebo Cancel. Po-
dobným postupom zmenı́me aj
názvy osı́. Dvojklikom na l’ubo-
volný bod grafu môžeme zmenit’
tvar, farbu a vel’kost’ symbolov
na vykreslenie dát. V prı́pade, že
v grafe máme hustú siet’ kriviek aj
s dátami, odporúča sa toto edito-
vanie vykonat’ z hlavného menu
Format → Curves . . . Opı́sané úp-
ravy vidı́me na obrázku 7.
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3.2.3. Nelineárna regresia pre súbor boxbod.dat

Aproximujme dáta znázornené v grafe na obrázku 7 exponenciálnou závislost’ou
v tvare

y = a[1− exp(−bx)],

ktorá je podl’a (NIST, 2006) modelovou funkciou pre tieto dáta. V hlavnom
menu klikneme na položku Analysis → Non-linear Curve Fit . . . a vyberieme
ponuku User defined. Do l’avého dolného okna zapı́šeme aproximačnú rovnicu
a*(1-exp(-b*x)), do okienka Name vpı́šeme názov funkcie, napr. boxbod, do
okienka Parameters vpı́šeme symboly a, b fitovaných parametrov oddelených
čiarkou a medzerou, potom kliknutı́m na položku Save vytvorenú funkciu ulo-
žı́me (objavı́ sa v zozname Function), pozri obrázok 8. Klikom myši na prvok
zoznamu z okna Category sa zobrazı́ v okne Function zoznam funkciı́ z danej kate-
górie (vybrané položky sa podfarbia modrou farbou). Vyberieme si samozrejme
tú našu boxbod. V prı́prave na fitovanie pokračujeme zaškrtnutı́m polı́čka Fit with
selected user function a potom kliknutı́m na položku Fit>>. Otvorı́ sa nám okno,
v ktorom nastavı́me štartovacie hodnoty Initial guesses, vyberieme algoritmus fi-
tovania, rozsah nezávisle premennej, maximálny počet iteráciı́ a toleranciu na
ukončenie procesu (obrázok 9). Kliknutı́m na položku Fit sa odštartuje fitovanie
a po jeho ukončenı́ sa na pracovnej ploche objavı́ tabul’kaResult Log s výsledkami,
pričom sa v grafe zobrazı́ regresná krivka (obrázok 10).

Výsledky fitovania môžeme vložit’do pol’a grafu kopı́rovanı́m tabul’ky cez schrán-
ku, pričom môžeme použit’ postup na editovanie a vkladanie textu do plochy
grafuGraph→ Add text. Výsledok vidı́me znázornený na obrázku 11 a uvádzame
tu aj tabul’ku výsledkov:
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Obrázok 8: Prvé okno na defi-
novanie požadaviek fitovania pre
dáta BoxBOD

Obrázok 9: Druhé okno na defi-
novanie požadaviek fitovania pre
dáta BoxBOD

16.09.2006 00:08:27 Fit1:
Non-linear fit of table3_2,
using function boxbod(x, a, b)=a*(1-exp(-b*x))
Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001
From x=1 to x=10
a=213.811069200896 +/- 0.723006
b=0.547218222427426 +/- 0.00611864
-----------------------------------
Chi^2/doF = 292.002
-----------------------------------
Iterations = 7
Status = success
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Obrázok 10: Hlásenie programu o ukončenı́ a o výsledkoch fitovania

Výpis nás informuje o dátume a čase fitovania, že toto fitovanie údajov z tabul’ky
table3 2 funkciou boxbod je prvé v tomto projekte, urobené nelineárnou metó-
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Obrázok 11: Nelineárna regresia dát BoxBOD exponenciálnou funkciou
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dou použitı́m Levenbergovho-Marquardtovho algoritmu s toleranciou 0.0001.
Ďalej sa uvádza rozsah nezávisle premennej x, fitované parametre a a b so štan-
dardnými neistotami, hodnota χ̃2, počet iteráciı́ a napokon hlásenie, že proces
fitovania bol ukončený úspešne.

3.2.4. Lineárna regresia funkciou y = ax

V krátkosti ešte opı́šeme postup lineárnej regresie modelovou funkciou

y = ax,

ktorú použijeme na fitovanie dát NoInt1 z kolekcie pre lineárnu regresiu už spo-
menutého inštitútu NIST (2006)14. V položkeAnalysismáme sı́ce ponuku Fit Linear
pre modelovou funkciou y = a + bx, ale akosi jej chýba možnost’ riešit’ prı́pad,
ked’ parameter a = 0. Pomôžeme si teda definovanı́m vlastnej funkcie y = a*x,
ktorú nazveme line. Zopakujeme postup, ktorý sme použili v predošlom prı́-
klade nelineárnej regresie, výsledok vidı́me na obrázkoch 12 a 13. Štartovaciu
hodnotu parametra a nacháme implicitnú a = 1 a taktiež algoritmus fitovania
ponecháme bez zmeny. Jediné čo zmenı́me je začiatočná hodnota nezávisle pre-
mennej, ktorú nastavı́me na hodnotu 0, aby sa graf zobrazil tak, ako ten, ktorý
je na WWW stránke inštitútu NIST. Grafický výsledok nie je „oslňujúci“, trochu
ho upravı́me, aby bolo jasné, že závislost’ má rozsah v oboch smeroch osı́ od 0.
Z hlavného menu vyberieme položku Format → Axes → Scale a začneme s úpra-
vami. Najprv zmenı́me x-ový rozsah, úpravu potvrdı́me klikom na Apply, postup

14 http://www.itl.nist.gov/div898/strd/lls/lls.shtml
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zopakujeme pre y-ový rozsah. Očakávali sme, že čiara fitu bude predĺžená do
začiatku súradnicového systému, nestalo sa tak, pozri obrázok 14.

Obrázok 12: Prvé okno na defi-
novanie požadaviek fitovania pre
dáta NoInt1

Obrázok 13: Druhé okno na defi-
novanie požadaviek fitovania pre
dáta NoInt1

Programu na jej vykreslenie pravdepodobne chýba bod (0, 0). Úpravu môžeme
vykonat’ dvoma spôsobmi:

1. Tabul’ku Fit2, ktorá obsahuje dáta na zobrazenie fitovanej čiary doplnı́me
bodom (0, 0) tak, že na jej začiatok vložı́me nový riadok s hodnotami x = 0
a y = 0. Klikneme na značku prvého riadku tabul’ky, vyfarbı́ sa na modro,
potom pravým klikom vyberieme z kontextového menu Insert Row. Do
vytvorených prázdnych polı́čok vložı́me nuly. Touto úpravou dosiahneme
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Obrázok 14: Prvé okno na definovanie požadaviek fitovania pre dáta NoInt1

to, že sa zobrazenie fitovanej čiary v grafe začne z bodu (0, 0). Teraz už
môžeme náš obrázok porovnat’ s obrázkom, ktorý je na WWW stránke
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inštitútu NIST, pozri obrázok 15. Výpis výsledku fitovania:
18.09.2006 16:27:38 Fit1:
Non-linear fit of table1_C2, using function line(x, a)=a*x
Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001
From x=60 to x=70
a=2.07438016528688 +/- 0.00463316
-----------------------------------
Chi^2/doF = 12.7273
-----------------------------------
Iterations = 2
Status = success

2. Môžeme zopakovat’postup z bodu 1 pre tabul’ku table1 s dátaminoint1.dat
a urobit’ nové fitovanie pre x od 0 do 70. Mohli by sme namietat’, že je to
„násilné konanie“ pridat’ do tabul’ky body a tak ovplyvnit’ fitovanie. Pri-
ložené výpisy však ukazujú, že v oboch prı́padoch sú zı́skané parametre
rovnaké. Výpis výsledku fitovania:
22.01.2006 01:51:44 Fit7:
Non-linear fit of table1_2, using function: user1(x, a, b)=a*x
Scaled Levenberg-Marquardt algorithm with tolerance = 0.0001
From x=0 to x=70
a=2.07438 +/- 0.00463
b=0.00000 +/- 0.00000
-----------------------------------
chisq/dof = 12.7273
-----------------------------------
Iterations = 2
Status = success
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Ako vzor na „kozmetickú“ úpravu grafu nám môže poslúžit’ prı́klad z ob-
rázku 21. Urobı́me ju pomôckami z položky Format a hotový projekt uložı́me.

Obrázok 15: Druhé okno na definovanie požadaviek fitovania pre dáta NoInt1
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3.3. Spôsoby zobrazenia viacerých grafov

Stáva sa, že sa vyžaduje zakreslenie dvoch (a niekedy aj viacerých) fyzikálnych
veličı́n rôznych rozsahov do jedného grafu alebo zlúčit’viac grafov do jedného
obrázku. Napr. chceme zobrazit’ priebeh rýchlosti a zrýchlenia vol’ného pádu
gul’ôčky vo viskoznom prostredı́. Za predpokladu, že pohyb gul’ôčky sa deje iba
vo zvislom smere vel’mi malou rýchlost’ou jej pohybová rovnica má tvar, pozri
napr. (UHRIN A KOL., 2006, str. 50)

4
3

πr3ρ
dv
dt

=
4
3

πr3gn(ρ∗ − ρ)− 6πrηv, (18)

kde r je polomer gul’ôčky, v rýchlost’ jej pohybu vzhl’adom na pokojnú tekutinu,
ρ je hustota (objemová hmotnost’) gul’ôčky, ρ∗ je hustota tekutiny, gn je normálne
tiažové zrýchlenie a η je viskozita tekutiny.

Predchádzajúca rovnica je lineárna diferenciálna rovnica prvého rádu s konštantnými
koeficientami s pravou stranou. Rieši sa známymi štandardnými metódami a jej
riešenie pre počiatočnú podmienku – rýchlost’ v čase nula sa rovná nule – má
tvar

v = v0

[
1− exp

(
−9

2
η t
r2ρ

)]
, (19)

v0 =
2 r2(ρ∗ − ρ) gn

9 η
.

Závislost’rýchlosti od času je teda daná rozdielom dvoch členov. Člen v0 je časovo
nezávislý, druhý člen je exponenciálne klesajúci, ktorý po určitom čase prakticky

http://people.tuke.sk/ladislav.sevcovic


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 61 z 101

Späť

Celá strana

Zatvoriť

Koniec

vymizne a gul’ôčka sa bude pohybovat’rovnomerne a priamočiaro rýchlost’ou v0.
Časový priebeh zrýchlenia bude rovný prvej derivácii rýchlosti v podl’a času

a = a0 exp
(
−9

2
η t
r2ρ

)
, (20)

a0 =
(ρ∗ − ρ)gn

ρ
.

Urobı́me numerický výpočet rýchlosti v a zrýchlenia a pre pohyb plexisklovej
gul’ôčky o polomere r = 1 mm vo vode v časovom intervale od 0 do 2 sekúnd.
Pomocou možnosti vkladania funkciı́ do grafov, z hlavného menu grafického
okna vyberieme Graph → Add Function. . . Čı́selné hodnoty v0, a0 a konštantného
člena v exponentoch sú:

v0 =
2 r2(ρ∗ − ρ) gn

9 η
=

2(10−3)2(998− 1 200) 9,81
9 · 10−3 = −0,44 ms−1

a0 =
(ρ∗ − ρ)gn

ρ
=

(998− 1 200) 9,81
1 200

= −1,65 ms−2

9
2

η t
r2ρ

=
9 · 10−3

2(10−3)21 200
= 3,75 s−1

Znamienko mı́nus v prvých dvoch výrazoch má fyzikálny význam. Uvedomme
si, že v a a sú vlastne z-ové zložky rýchlosti a zrýchlenia v pravouhlom súradni-
covom systéme a teda môžu byt’ kladné aj záporné.

V prvom kroku vytvorı́me čı́selné hodnoty na zobrazenie rýchlosti v a zrých-
lenia a, ktore použijeme na tvorbu kombinovaných grafických výstupov. Za-
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čneme novým projektom, potom z položky File v hlavnom menu vyberieme
New Function Plot. Otvorı́ sa ponuka Add function curve, do okienka f(x)= vlo-
žı́me 0.44*(1-exp(-3.75*x)) pre x od 0 do 2 a necháme vypočı́tat’ 100 hodnôt,
klikneme na OK. Okno programu sa prepne do grafického módu a zobrazı́ sa
priebeh nami zadanej funkcie f(x)=0.44*(1-exp(-3.75*x)) vo forme spojitej
čiary, obrázok 16.

Obrázok 16: Grafický priebeh vzt’ahu 19
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Vypočı́tané hodnoty potrebujeme uložit’ do dátového súboru. Kurzorom myši
na čiare vykonáme dvojklik, otvorı́ sa editor parametrov čiary. Klikneme na po-
ložku Worksheet, aktivuje sa tabul’kové okno a zobrazı́ sa tabul’ka vypočı́taných
hodnôt rýchlosti, ktorú uložı́me postupom File→ Export ASCII, vyberieme odde-
l’ovač stĺpcov a pomenujeme ju rychlost.dat. Postup zopakujeme na vytvorenie dát
zrýchlenia, do okienka f(x)= vložı́me 1.65*exp(-3.75*x) pre x od 0 do 2 a opät’
necháme vypočı́tat’ 100 hodnôt. Dátový súbor uložı́me pod menom zrychlenie.dat.
Teraz už máme uložené dáta potrebné na vytvorenie ukážok.

3.3.1. Zobrazenie dvoch priebehov v jednom grafe
Uložené dáta rychlost.dat a zrychlenie.dat použijeme na vytvorenie dvoch priebe-
hov v jednom grafe. Začneme novým projektom, z ktorého vymažeme prázdnu
tabul’ku a budeme doňho importovat’ naše dáta, File → Import ASCII → Multiple
files. . . alebo na nástrojovej lište klikneme na ikonku Import multiple data files

Vyhl’adáme naše súbory, pričom súčasným stlačenı́m klávesu Ctrl a klikom myši
ich označı́me na importovanie. V okne programu budeme mat’dve tabul’ky table2
s dátami rýchlosti a table3 s dátami zrýchlenia. Označı́me stĺpce tabul’ky table2
a z položky Plot hlavného menu vyberieme bodové zobrazenie Scatter, otvorı́ sa
grafické okno s priebehom rýchlosti. Do tohto grafu chceme vložit’ aj priebeh
zrýchlenia. Na túto operáciu použijeme postup opı́saný v časti 3.2.4 na strane 56.
Klikneme teda do okienka 1 a v editore Add/Remove curves presunieme dáta
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table3 z okna Available data do okna Graph contents. Výsledok vidı́me na ob-
rázku 17. Graf upravı́me pomôckami z položky Format a projekt nezabudnime
uložit’. Upravený graf vidı́me na obrázku 18. Pre d’al’šie použitie môžeme graf
uložit’ v niektorom z grafickych formátov cez hlavné menu položkou File →
Export Graph → Current, napr. eps.

Obrázok 17: Zobrazenie dát zo
súčasne importovaných súborov
rychlost.dat a zrychlenie.dat

Obrázok 18: Upravený graf
z obrázku 17

3.3.2. Zobrazenie dvoch grafov v jednom okne

V tejto časti opı́šeme postup ako zlúčit’viac grafov do jedného obrázka použije na
to naše dáta rychlost.dat a zrychlenie.dat. Opät’ začneme prácu novým projektom,

http://people.tuke.sk/ladislav.sevcovic


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 65 z 101

Späť

Celá strana

Zatvoriť

Koniec

z ktorého vymažeme prázdnu tabul’ku a do tohto projektu importneme naše data
postupom z predchádzajucej časti. Z tabul’kového okna sériou prı́kazov Plot →
Scatter vykreslı́me priebeh rýchlosti.

Obrázok 19: Neupravené grafy
priebehov rýchlosti v a zrýchlenia a
v jednom grafickom okne

Obrázok 20: Trochu upravené
grafy z obrázku 19

Do aktı́vneho grafického okna, v ktorom je graf priebehu rýchlosti v, vložı́me
nový graf pomocou ponuky Graph → Add Layer z hlavného menu programu,
potvrdı́me implicitnú ponuku kliknutı́m na položku Guess. V l’avom hornom
okne pribudne okienko 2 , klikneme naň dvakrát, otvorı́ sa editor Add/Remove
curves a môžeme presunút’ tabul’ku table3 do Graph contents. Výsledok nášho
snaženia vidı́me na obrázku 19. Grafy upravı́me pomôckami z položky Format
a vytvorený projekt nezabudnime uložit’. Upravené grafy sú na obrázku 20.
Na d’alšie použitie môžeme obrázok s grafmi uložit’ v niektorom z grafickych
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formátov cez hlavné menu položkouFile→ Export Graph→ Current, napr. eps, png,
jpeg, bmp, pbm, pgm, ppm, xbm, xpm. Na obrázku 21 sú oba projekty znázornené
v jednom grafickom okne, na postup vyhotovenia pozorný čitatel’ už iste prı́de
aj sám.

Obrázok 21: Zobrazenie dvoch grafov v jednom okne a dvoch priebehov v jednom grafe
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Stručne sme ukázali niektoré často použı́vané procedúry spracovania dát a tvorby
grafov. Týmito jednoduchými prı́kladmi sme samozrejme nevyčerpali všetky
možnosti programuQtiPlot. Dobrým zdrojom d’alšı́ch informáciı́ na prácu s prog-
ramom je elektronický off-line HTML manuál prı́stupný na URL adrese: http:
//soft.proindependent.com/manuals.html.

V priloženej tabul’ke uvádzame zoznam programom podporovaných matematic-
kých operátorov a zabudovaných funkciı́, ktoré môžeme použı́vat’ na vytvorenie
vlastných funkciı́, pri matematických operáciach s dátami v tabul’kách a pod.

ZOZNAM MATEMATICKÝCH OPERÁTOROV A FUNKCIÍ PROGRAMU QtiPlot

Názov Popis

+ súčet

− rozdiel

∗ násobenie (a*b = a·b)

/ podiel, delenie

ˆ umocnenie (a^b = ab)

and logické AND (vracia 0 alebo 1)

or logické OR (vracia 0 alebo 1)

xor logické Exclusive OR (vracia 0 alebo 1)

< menšie ako (vracia 0 alebo 1)

pokračovanie tabul’ky na d’al’šej strane
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(pokračovanie tabul’ky z predošlej strany)

Názov Popis

<= menšie ako alebo rovná sa (vracia 0 alebo 1)

== rovná sa (vracia 0 alebo 1)

>= väčšie ako alebo rovná sa (vracia 0 alebo 1)

> väčšie ako (vracia 0 alebo 1)

! = nerovná sa (vracia 0 alebo 1)

abs(x) absolútna hodnota x

acos(x) arkus kosı́nus

acosh(x) arkus hyperbolický kosı́nus

asin(x) arkus sı́nus

asinh(x) arkus hyperbolický sı́nus

atan(x) arkus tangens

atanh(x) arkus hyperbolický tangens

avg(x1,x2,x3,...) stredná hodnota argumentov

bessel j0(x) Besselova funkcia prvého druhu J0(x) rádu 0

bessel j1(x) Besselova funkcia prvého druhu J2(x) rádu 1

bessel jn(x,n) Besselova funkcia prvého druhu Jn(x) rádu n

bessel y0(x) Besselova funkcia druhého druhu Y0(x) rádu 0

pokračovanie tabul’ky na d’al’šej strane
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(pokračovanie tabul’ky z predošlej strany)

Názov Popis

bessel y1(x) Besselova funkcia druhého druhu Y1(x) rádu 1

bessel yn(x,n) Besselova funkcia druhého druhu Yn(x) indexu n

beta(a,b) Beta funkcia, B(a, b) = Γ(a) · Γ(b)/Γ(a + b)

cos(x) kosı́nus x

cosh(x) hyperbolický kosı́nus x

erf(x) chýbová funkcia

erfc(x) erfc(x)=1-erf(x)

erfz(x) hustota pravdepodobnosti normálneho rozdelenia Z(x)

erfq(x) koncová čast’ normálneho rozdelenia Q(x)

exp(x) exponenciálna funkcia so základom e

gamma(x) funkcia Γ(x)

gammaln(x) logaritmus funkcie Γ(x)

hazard(x) h(x)=erfz(x)/erfq(x)15

if(e1,e2,e3) ked’ je e1 pravdivé , výpočı́ta sa e2 a ešte e3

pokračovanie tabul’ky na d’al’šej strane

15V staršej literatúre sa uvádza pojem hazard function ako ekvivalent pojmu hazard rate alebo
failure rate použı́vaneho v teórii obnovy a poist’ovnı́ctve, v slovenčine ako intenzita poruchy
(úmrtnosti). Je definovaná ako h(x) = f (x)/(1− F(x)), kde f (x) a F(x) je hustota a distribučná
funkcia doby životnosti nejakého prvku (J. Skřivánek).
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(pokračovanie tabul’ky z predošlej strany)

Názov Popis

ln(x) prirodzený logaritmus x

log(x) dekadický logaritmus x

log2(x) logaritmus x so základom 2

min(x1,x2,x3,...) minimum zo zoznamu argumentov

max(x1,x2,x3,...) maximum zo zoznamu argumentov

rint(x) zaokrúhlenie na najbližšie celé čı́slo

sign(x) funkcia znamienka x

sin(x) sı́nus x

sinh(x) hyperbolický sı́nus x

sqrt(x) druhá odmocnina z x

tan(x) tangens x

tanh(x) hyperbolický tangens x
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4. Program Kpl

ProgramKpl je jednoduchý z pohl’adu ovládania, poskytuje rozsiahle možnosti na
vyhladzovanie, optimalizáciu a numerické operácie s nameranými dátami (napr.
derivovanie, integrovanie); môžeme ho dopĺňat’ vlastnými funkciami a kniž-
nicami, ktoré sa napı́šu a skompilujú v programovacom jazyku C. Na roz-
diel od programu QtiPlot neumožňuje štatistické výpočty a charakteristiky dát.
V d’alšı́ch častiach opı́šeme prácu s verziou Kpl 3.3 pre grafické použı́vatel’-
ské prostredie KDE 3.5.2. Domovská internetová stránka programu je na ad-
rese http://frsl06.physik.uni-freiburg.de/privat/stille/kpl/. Autor Werner
Stille ponúka k programu on-line prı́ručku prı́stupnú na URL adrese http://
frsl06.physik.uni-freiburg.de/privat/stille/kpl/book/index.html . Na prácu
v Kplmáme k dispozı́cii jedno pracovné okno, pozri obrázok 22.

4.1. Ovládacie možnosti programu Kpl

Spustenie Kpl v prostredı́ OS GNU/Linux sa dá uskutočnit’ troma spôsobmi:16

• kliknutie na ikonu Kpl na pracovnej ploche (ked’ ju máme vytvorenú),
• Menu→ Kancelária→ kliknutie na Kpl (ked’sme program inštalovali z deb

balı́čka),
16V prı́pade, ked’ inštaláciu vykonáte zo zdrojových súborov, musı́ sa cesta na spustenie zMenu

nastavit’ manuálne. Autor z vlastnej skúsenosti odporúča spušt’at’ program z pracovnej plochy
pomocou vytvorenej ikonky s odkazom na binárny súbor kpl.
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Obrázok 22: Pracovné okno programu Kpl

• z prı́kazového riadka X terminálu prı́kazom kpl.

Na obrazovke sa zobrazı́ okno programu s prı́slušnými ponukami a ovládacı́mi
prvkami v hlavnom menu (obrázok 22). Zatvorenie Kpl sa vykoná cez záložku
File a potom Quit alebo stlačenı́m klávesov Ctrl + Q (prı́padne Alt + F4).
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Opät’, pri prvom čı́tanı́ tejto kapitoly môže čitatel’, ktorý sa chce rýchlo oboznámit’
s použı́vanı́m programu čast’ 4.1 preskočit’ a pokračovat’ v čı́tanı́ čast’ou 4.2 na
strane 76.

Hlavné menu programu obsahuje tieto položky:

File Edit View Settings Help

Opı́šeme tie položky, ktoré sú potrebné na základné zoznámenie sa s možnos-
t’ami Kpl. Položky označené hviezdičkou ∗ sa aktivujú len v tom prı́pade, ked’ je
otvorený grafický alebo dátový súbor.

File

New vytvorenie nového projektu
Open Plot File . . . otvorenie súboru s prı́ponou .kpl,

editácia už vytvoreného projektu
Open Data File . . . otvorenie súboru s prı́ponou .dat,

možnost’ výberu desatinnej bodky alebo čiarky
Open Recent desat’ naposledy otvorených projektov
Save∗ uloženie dokumentu pod pôvodným menom
Save As . . . ∗ uloženie dokumentu pod novým menom
Close∗ zatvorenie aktuálneho projektu
Print∗ vytlačenie aktı́vneho grafu
Display Plot∗ zobrazenie grafickej prezentácie alebo obno-

venie zobrazeného grafu
PostScript Output vol’ba orientácie grafického listu na konverziu;
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na výšku alebo na šı́rku
PostScript Preview vol’ba orientácie náhl’adu grafu;

na výšku alebo na šı́rku
New Window otvorenie nového pracovného okna programu
Close Window zatvorenie aktuálneho pracovného okna

a ukončenie programu
Quit ukončenie práce s programom Kpl

Edit

Undo∗ zrušı́ posledný vykonaný krok
Redo∗ vráti posledný vykonaný krok
Items . . . jedna z najdôležitejšı́ch položiek, umožňuje vkladat’,

editovat’ a fitovat’ objekty a položky v grafe (napr. funkcie,
polia, splajnové krivky a pod.)

View

Zoom In (Ctrl++) zväčšovanie krokom
Zoom Out (Ctrl+−) zmenšovanie krokom
Zoom . . . nastavenie faktora zväčšenia/zmenšenia (%)
Redisplay∗ (F5) aktuálny dátový alebo grafický súbor sa znova

načı́ta a zobrazı́, aktivuje sa funkcia Autoplot
Reload Periodically nastavenie periodického obnovovania zobra-

zenia, aktivuje sa funkcia Autoplot
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Settings

Hide Toolbar skrytie/zobrazenie hlavného menu
Hide Statusbar skrytie/zobrazenie stavovej lišty
Show Function Source zobrazenie zdrojového súboru funkcie

v dialógu vol’by jej parametrov
Autoplot automatické zobrazenie projektu po na-

čı́tanı́ dátového alebo grafického súboru
Add Files (Insert) pridanie nového dátového alebo grafické-

ho súboru do aktuálneho s vykreslenı́m
Calculate PS Bounding Box automatický výpočet hranı́c postscript-

ového okna grafu, bez aktivácie tejto po-
ložky sa vypočı́tajú hranice k niektorému
rozmeru strany (napr. A4 na výšku)

Print PS Output zobrazenie dialógu tlače postscriptového
súboru po jeho vytvorenı́

Save Absolute Paths do grafického súboru sa uložı́ absolútna
cesta k dátam a knižniciam

Unsaved Changes Warning zobrazenie varovania o neuloženı́ súboru
Save Settings At End uloženie všetkých nastavenı́ aktuálneho

zobrazenia pri ukončenı́ programu
Save Settings uloženie všetkých nastavenı́ aktuálneho

zobrazenia
Configure Shortcuts . . . definovanie vlastných klávesových

skratiek
Configure Toolbars . . . pridanie/odobratie ikoniek do hlavného
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menu
Configure Notifications . . . nastavenie hlásenı́ a varovanı́ programu
Configure Kpl . . . niektoré základné implicitné nastavenia

programu

Help

Kpl Handbook otvorenie elektronického manuálu, ked’ je nainštalo-
vaný

Report Bug . . . dialóg na oznamovanie chýb programu autorovi
e-mailovou poštou

About Kpl základné informácie o programe Kpl
About KDE základné informácie o grafickom prostredı́ KDE

4.2. Prı́klady použitia programu

4.2.1. Importovanie dát, ich zobrazenie a úprava grafu

Importovanie dátoveho súboru boxbod.dat

Tak, ako v prı́pade programu QtiPlot, aj program Kpl a jeho funkcionalitu pre-
skúšame dátami z internetovej stránky Národného inštitútu štandardov a tech-
nológiı́ Spojených štátov amerických (NIST, 2006). Stiahnite si dáta z kolekcie
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pre nelineárnu regresiu s názvom BoxBOD17, ktoré sú zaradené do kategórie
s vysokou náročnost’ou na spracovanie. Tabul’ku uložte do dátového súboru
s názvom boxbod.dat.

ProgramKplmá sı́ce vlastný editor tabuliek, ale s obmedzenými možnost’ami for-
mátovania, preto si na vytvorenie tabul’ky vyberme radšej nejaký textový ASCII
editor (napr. Kate, gedit, KSpread a pod.). Dátový súbor vytvárame a editujeme
v stĺpcovom formáte, a pri jeho ukladanı́ do pracovného priečinka mu pridávame
prı́ponu dat. Symbolom desatinnej rádovej čiarky môže byt’desatinná čiarka alebo
desatinná bodka a ako oddel’ovač (separátor) stĺpcov odporúčame použit’ tabulá-
tor (Tab) alebo medzernı́k (Space). Dátový súbor môžeme importovat’ dvoma
spôsobmi:

1. Vyvolanı́m ponúk File→ Open Data File . . . sa otvorı́ dialógové okno, v kto-
rom zvolı́me symbol desatinnej rádovej čiarky a vyhl’adáme na disku súbor
na importovanie.

2. Otvorı́me program Kpl a potom nejaký program na spravovanie súborov
(napr. Konqueror alebo Krusader), v ktorom vyhl’adáme súbor, ktorý chceme
zobrazit’. Označı́me ho l’avým klikom myšky a t’ahom ho premiestnime
do okna programu Kpl, kde klik uvol’nı́me (metóda Drag and Drop), pozri
obrázok 23.

„Surový“ graf z obrázku 23 budeme upravovat’ vyvolanı́m položky Items . . .
Možeme ju aktivovat’ dvoma spôsobmi, pravým klikom myši do prázdmeho
pol’a v okne programu (mimo pol’a grafu) a z kontextového menu vyberieme

17 http://www.itl.nist.gov/div898/strd/nls/nls_main.shtml
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Obrázok 23: Importovanie a zobrazenie dát metódou t’ahaj a pust’
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žiadanú položku alebo vyvolanı́m ponúk Edit → Items . . . , pozri obrázok 24.

Obrázok 24: Pracovné okno položky Items . . .

Po pridanı́ legendy (výberom New), označenı́ a zmene modulov osı́ (pozri na
strane 90), zmene zafarbenia a symbolov dátových bodov (označenı́m a výberom
Edit) dostaneme takýto výsledok:

Obrázok 25: Upravený graf z obrázku 23

http://people.tuke.sk/ladislav.sevcovic


Domovská stránka

Print

Titulná strana

Obsah

JJ II

J I

Strana 80 z 101

Späť

Celá strana

Zatvoriť

Koniec

4.2.2. Nelineárna regresia pre súbor boxbod.dat

Tak, ako v prı́pade programu QtiPlot aproximujme dáta znázornené v grafe na
obrázku 25 exponenciálnou závislost’ou v tvare

y = a[1− exp(−bx)],

ktorá je podl’a (NIST, 2006) modelovou funkciou pre tieto dáta. Program impli-
citne takúto funkciu neponúka, ale môžeme ju napı́sat’ ako skript v programo-
vacom jazyku C, napr. boxbod.c, a skompilovanı́m vytvorit’ knižnicu (modul)
boxbod.so.

Postup je nasledovný: v textovom editore napı́šeme naprı́klad takéto funkcie
v jazyku C. Prvá boxbod 1 bude na vykreslenie fitovanej čiary do grafu, druhá
boxbod 2 na iteráciu:
/****************************************************************/

/* boxbod.c 2D functions for Kpl */

/* */

/* Copyright (C) 2006 by Ladislav Sevcovic */

/* <ladislav.sevcovic@tuke.sk> */

/* Released under the GPL; see file LICENSE for details. */

/* */

/* Use the following command to compile the C function */

/* and create a shared library: */

/* gcc -Wall -shared -fPIC -o boxbod.so boxbod.c -lm */

/* Do this in a X terminal windows (shell). */

/* At the X terminal type: nm boxbod.so>boxbod.def */

/* */
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/* exponential(x, p) calculates of exponential */

/* Returns: p[0] * (1 - exp(-p[1] * x)) */
/****************************************************************/

#include <math.h>

/****************************************************************/

double boxbod_1(double x, const double* p)

{

return(p[0]*(1-exp(-p[1]*x)));

}

/****************************************************************/

double boxbod_2(double x, const double* p)

{

int i;

double f;

f = p[0];

for (i = 0; i < 3; i += 1)

f == p[i] * (1 - exp(- p[i + 1] * x));

return f;

}

/****************************************************************/

Súbor uložı́me do pracovného priečinka pod menom boxbod.c a do prı́kazového
riadka v okne X terminálu najprv napı́šeme18

gcc -Wall -shared -fPIC -o boxbod.so boxbod.c -lm

18Súčast’ou OS GNU/Linux je aj kompilátor gcc jazyka C a rad d’alšı́ch programátorských ná-
strojov. Program nm vytlačı́ tabul’ku symbolov (zoznam názvov) v abecednom poradı́ pre jeden
alebo viac objektových súborov. Výstup obsahuje pre každý symbol meno, hodnotu, typ, vel’kost’
a pod.
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a stlačnı́m klávesu Enter prebehne kompilácia nášho skriptu do binárnej knižnice
boxbod.so. Potom napı́šeme

nm boxbod.so>boxbod.def

a opätovným odoslanı́m sa vytvorı́ tabul’ka symbolov. Dva skompilované súbory
boxbod.so a boxbod.def použijeme na fitovanie, môžeme ich teda presunút’ do
pracovného priečinka, v ktorom máme ostatné súbory s dátami pre Kpl alebo do
osobitného podpriečinka, v ktorom budú len knižnice (aj budúce).

Teraz už môžeme začat’ s fitovanı́m dát, v okne položky Items (obrázok 24)
klikneme na ponuku New a potom na ponuku Function (obrázok 26). Vyhl’adáme
si našu knižnicu boxbod.so a z nej vyberieme funkciu boxbod 1, doplnı́me xmax
na 10, vyberieme symbol, vel’kost’a farbu fitovacej čiary v grafe a výber ukončı́me
potvrdenı́m Apply a potom OK. Prejdeme opät’ do okna Items, kde klikneme na
novovytvorenú položku Function a potom na okienko Fit, čı́m sa nám otvorı́ okno
Parameter fit, pozri obrázok 27.
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Obrázok 26: Okno položky Function na vykreslenie fitovanej funkcie
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Obrázok 27: Výrez okna položky Parameter
fit so štartovacı́mi parametrami iteračného
procesu fitovania

Obrázok 28: Výrez okna položky Parameter
fit s výsledkami iteračného procesu fitovania

Zaškrtneme l’avé okienka × pre parametre p0 a p1 a do pravých vpı́šeme ich
štartovacie hodnoty, pre p0=100 a pre p1=0.75. Fitovanie bude nelineárne, preto
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zaškrtneme aj okienko× Nonlinear fit. Kliknutı́m do položkyModel sa otvorı́ okno
Error model function, v ktorom opät’ vyhl’adáme knižnicu boxbod.so a z nej ten-
toraz vyberieme funkciu boxbod 2, ako argument zvolı́me ycolumn. Kliknutı́m na
položku Edit zadáme štartovacie parametre iteračného procesu (iteračný proces
sa ukončı́ dobre aj so začiatočnými hodnotami p0=1 a p1=1). Výsledné parametre
fitovanej funkcie y=p[0]*(1-exp(-p[1]*x)) sa vpı́šu do prı́slušných okienok pa-
rametrov (obrázok 28). Kliknutı́m na položku Apply sa vysledok fitovania zobrazı́
v grafe (obrázok 29). Prácu s fitovanı́m ukončı́me kliknutı́m na položku OK. Do
grafu vložı́me legendu, názvy osı́ a tak d’alej (pozri Kapitolu 5).

Obrázok 29: Výsledný graf s fitovanou krivkou pre dáta boxbod.dat
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4.2.3. Lineárna regresia funkciou y = ax

Podobne ako v programe QtiPlot aj na tomto mieste v krátkosti ešte opı́šeme
postup lineárnej regresie modelovou funkciou

y = ax,

ktorú použijeme na fitovanie dát NoInt1 z kolekcie pre lineárnu regresiu už spo-
menutého inštitútu NIST (2006)19, aby sme mohli výsledky oboch programov
porovnat’.

Aj v tomto prı́pade tabul’ku dát môžeme doplnit’bodom (0, 0), aby sme zı́skali vý-
sledné grafické zobrazenie v takom tvare, aké je na WWW stránke inštitútu NIST.
Úpravu prevedieme takto: z ponuky Items označı́me položku Array a klikneme
na okno Edit. Otvorı́ sa nám nové okno, v ktorom zaškrtneme okienko × Internal
data a potom vyberieme ponuku Edit. Do odsadeného prvého riadka zapı́šeme tri
nuly s medzerami 0 0 0, upravu potvrdı́me klikom na Apply a editor zatvorı́me
klikom na OK.

Zı́skanie optimálneho parametra a bude jednoduchššie ako v predošlom prı́pade,
lebo môžeme na to použit’ zabudovanú funkciu programu Kpl (samozrejme,
môžeme si napı́sat’aj vlastnú). Postup bude podobný, ako pri nelineárnej regresii,
s tým rozdielom, že na fitovanie použijeme knižnicu fkt.so, z ktorej vyberieme
funkciu polynom.

19 http://www.itl.nist.gov/div898/strd/lls/lls.shtml
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Obrázok 30: Výrez okna položky Parameter
fit so štartovacı́m parametrom

Obrázok 31: Výrez okna položky Parameter
fit s výsledkom procesu fitovania

Úprave hodnôt v tabul’ke noint1.dat sa však môžeme vyhnút’. Na rozdiel od
postupu v prı́pade úpravy v programe QtiPlot (pozri na strane 56) však nemu-
sı́me upravovat’ žiadnu tabul’ku, lebo program Kpl údaje na vykreslenie krivky
fitovanej funkcie neukladá do osobitnej tabul’ky. Vyvolanı́m okna položky Items
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označı́me v nej položku Function a klikneme na okno Fit. Otvorı́ sa nám okno
Parameter fit, v ktorom z l’avých okienok pre parametre zaškrtneme len okienko
pre parameter × p1, do pravého okienka vpı́šeme štartovaciu hodnotu p1=1
a okienko Nonlinear fit zostane nezaškrtnuté, pozri obrázok 30. Výsledky vi-
dı́me na obrázkoch 31 a 32.

Vytvorené grafy upravené podl’a odporúčanı́ z kapitoly 5 môžeme uložit’vo for-
máte *.ps alebo *.eps na d’alšie spracovanie (z hlavného menu File→ PostScript
Output).

Obrázok 32: Výsledný graf s fitovanou krivkou pre dáta noint1.dat
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Jeden obrázok má hodnotu tisı́c
slov.

STARÉ ČÍNSKE PRÍSLOVIE

5. Niekol’ko pravidiel na tvorbu grafov

Z precı́zne vyhotoveného grafu nameranej fyzikálnej závislosti dvoch veličı́n
sa dajú s dostatočnou mierou presnosti určit’ charakteristiky funkcie. Je možné
napr. určit’ polohu extrémov, inflexných bodov, pri lineárnej závislosti odčı́tat’
z grafu smernicu priamky atd’. Graf je vždy názornejšı́ ako tabul’ka, tabul’ka
je však vždy presnejšia. Grafu dávame prednost’, ked’ chceme ukázat’ priebeh,
tendenciu, štruktúru alebo obrazec.

Dôvod je jednoduchý a spočı́va v rýchlom, pohodlnom a názornom prijı́manı́
obrazovej informácie človekom. Dalo by sa povedat’, že graf slúži na rýchlu
kvalitatı́vnu orientáciu v nameranej závislosti a ak nás zaujı́majú podrobnejšie
kvantitatı́vne údaje, z pamäte počı́tača si necháme zobrazit’ tabul’ku funkcie resp.
analytický predpis, interpolačnú formulu atd’. Z dôvodu názornosti je grafické
zobrazenie funkciı́ vel’mi časté i vo fyzikálnej literatúre a takmer každá nameraná
závislost’ je reprezentovaná grafom. Na zhotovenie grafov nie sú jednoznačné
pravidlá a v každom odbore sú trocha odlišné zvyklosti určené napr. tradı́ciou,
typografickými možnost’ami časopisov a pod. Na zrozumitel’ný a prehl’adný graf
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budú kladené tieto požiadavky:

1. Modul stupnice grafu zvolı́me tak, aby graf bol dostatočne vel’ký, t. j. inter-
val nezávisle premennej má byt’ zobrazený na „vodorovnej“ osi viac ako
na dvoch tretinách „vodorovného“ rozmeru grafu a analogicky interval na
„zvislej“ osi. Pod pojmom modul stupnice rozumieme podiel intervalu na-
meraných (v prı́pade extrapolácie potrebných) hodnôt fyzikálnej veličiny
k dĺžke osi, povedzme v mm, na ktorú chceme interval zobrazit’. Napr. ob-
rázok 33 znázorňuje graf, v ktorom ked’ zvolı́me dĺžky osı́ 120 mm bude
modul vodorovnej stupnice M1 = (90 V− 40 V)/120 mm = 0,4166 V/mm
a zvislej stupnice M2 = (7 A− 1 A)/120 mm = 0,05 A/mm.

2. Osi vyznačı́me plnou úsečkou a označı́me jednotkami v okruhlej zátvorke,
v ktorých je fyzikálna veličina vynášaná. Osi nekalibrujeme hodnotami,
ktoré sme namerali, ale takými hodnotami, medzi ktorými je l’ahká inter-
polácia.

3. V každom prı́pade do grafu vhodnými symbolmi vyznačı́me namerané
hodnoty. Ak je v jednom grafe viac priebehov alebo na jednom papieri viac
grafov, pre rôzne priebehy volı́me rôzne symboly na označenie nameraných
hodnôt (napr. plné body pre jeden graf, trojuholnı́ky pre d’alšı́ atd’.). Od
nameraných hodnôt nevedieme na osi žiadne čiary (pozri obrázok 33)20.

4. Každý graf opı́šeme stručným komentárom, aby bolo jasné, akú závislost’
graf vyjadruje.

20Tento obrázok bol vytvorený programom QtiPlot, uložený vo formáte EPS a potom progra-
mom epstopdf konvertovaný do formátu PDF.
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Voltampérovácharakteristika

PrúdI
(A)

1
2
3
4
5
6
7

NapätieU(V)405060708090

vláknoAvláknoB

Obrázok 33: Prı́klad nakresle-
ného grafu, ktorý znázorňuje vol-
tampérovú (VA) charakteristiku
dvoch kovových vlákien

Meranie je zat’ažené chybami a po vynesenı́ name-
raných hodnôt zistı́me, že body sú „rozhádzané“.
Treba sa rozhodnút’ ako preložit’ cez namerané
body čiaru. Ak sme meranie vyhodnotili metódou
najmenšı́ch štvorcov a určili parametre z rovnı́c
(3), potom pretabelujeme funkciu F(x, p1, . . . , pk)
(Kapitola 2) a túto funkciu vynesieme do grafu.
Zı́skame tak jednoznačne určenú (v zmysle vyrov-
návajúceho počtu vyrovnávajúcu) hladkú čiaru.
Napr. pri lineárnej závislosti y = a + bx zistı́me, že
táto priamka neprechádza všetkými nameranými
bodmi, ale približne polovica bodov je nad a pri-
bližne polovica bodov pod priamkou. V ostatných
prı́padoch, ked’ nemôžeme použit’ vyrovnávajúci
počet, nemáme k dispozı́cii ani opodstatnený ná-
vod ako preložit’ čiaru cez namerané body, tu zá-
ležı́ vel’a od skúsenosti experimentátora. Oblasti
zat’ažené vel’kými chybami sa premerajú znova,
hustejšie resp. inými metódami. Čiaru, ktorú na-

rysujeme, sa snažı́me viest’tak, aby bola vyrovnaná, t. j. nemala fyzikálne neopod-
statnené skoky, zalomenia a extrémy, aby bola dostatočne hladká, aby približne
rovnaký počet nameraných bodov bol nad i pod čiarou a súčet štvorcov name-
raných hodnôt od čiary by mal byt’ čo najmenšı́. Majme stále na pamäti, že čiara
v takomto grafe má viac-menej kvalitatı́vny význam.

Pri dôslednejšı́ch experimentoch sa merania v každom bode opakujú za rovna-
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kých podmienok a každý bod v grafe je spracovaný vyššie opı́sanými metódami
pre opakované merania. V takýchto prı́padoch sa zvykne okrem najpravdepo-
dobnejšej hodnoty (nameranej hodnoty) vyznačit’ v grafoch aj štandardná neis-
tota pre každý bod zvlášt’.

Zhrnutie

• Obrys grafu nesmie byt’ nikdy nakreslený hrubšou čiarou, ako čiary v plo-
che grafu, taktiež úsečky, ktoré vyznačujú chyby meraných hodnôt, nemôžu
byt’ výraznejšie ako vlastné krivky alebo priamky. Kóty na osiach musia
udávat’ l’ahko delitel’né hodnoty.

• Do grafu umiestňujeme čo najviac informáciı́, menej do legendy grafu.

• Dbáme na prehl’adnost’ grafu a čitatel’nost’ pı́sma v grafe. Na popis osı́ sa
častejšie použı́vajú verzálky (vel’ké pı́smená), pre informácie vpı́sané do
grafu mı́nusky (malé pı́smená) pı́sma z rodiny Sans Serif.

• Osi grafu nemajú byt’ dlhšie, ako určuje výskyt pokusných bodov, v grafe
teda nemajú byt’ prázdne plochy. Osi nemusia začı́nat’ nulovou hodnotou.

• Vhodným tvarom grafu je obvykle štvorec alebo obdĺžnik (na ležato). Uzav-
retie grafu do štvorca alebo obdĺžnika zjednodušuje určenie hodnôt jednot-
livých bodov. Kóty môžeme na protil’ahlých osiach opakovat’bez doplnenia
čı́sel.

• Poznáme šest’ hlavných druhov (typov) grafov:
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– bodový garf (scattergram),

– čiarový (priebehový) graf (line graph),

– stĺpcový graf (bar graph),

– histogram (vlastne stĺpcový graf so stĺpcami umiestnenými tesne vedl’a
seba),

– koláčový diagram (pie graph),

– trojrozmerný graf (three-dimensional graph).

• Dbáme na to, aby v bodovom a čiarovom grafe boli symboly a charakter
jednotlivých čiar l’ahko odlı́šitel’ný aj pri zmenšenı́ tlače. V grafoch pripra-
vovaných na počı́tači je potrebné správne zadat’ požadované vzdialenosti
a popis kót, zvolit’ len výrazné symboly, snažit’ sa všetko vyjadrit’ jednou
farbou a pod.
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Záver

Ked’ hovorı́me o prı́prave experimentálnych dát na prezentáciu a d’alšie vyhod-
nocovanie s použitı́m osobného počı́tača, potom samozrejme musı́me venovat’
náležitú pozornost’ nielen samotným programom, ale aj metódam a postupom
spracovania dát.

Opis dvoch známych produktov z tejto oblasti nám v základoch objasnil ich vše-
obecné aj niektoré špecifické vlastnosti. Domnievame sa, že prvoradým prı́nosom
štúdia tejto prı́ručky sú základné informácie o ovládanı́ opı́saných programov
a zı́skane poznatky, ako tvorit’ grafické výstupy matematických funkciı́ a spra-
covaných experimentálnych dát na d’alšiu kvalitatı́vnu analýzu prı́padne pre-
zentáciu. Podklady k tejto prı́ručke vznikali v priebehu práce autora na projekte
KEGA Využitie Open-Source softvéru vo výučbe na vysokých školách. Ciel’om nebolo
vykonanie nejakej recenzie, na základe ktorej by sa dali oba programy rigorózne
ohodnotit’. Každý z prezentovaných programov má svoje prednosti aj nedostatky
(stále sa vyvı́jajú a vylepšujú). Porovnanie výsledkov uvedených v tabul’ke 2 má
čitatel’ovi oboznámenému s funkčnost’ou a hlavnými možnost’ami programov
ul’ahčit’ rozhodovanie sa, ktorému z nich dá prednost’ pri výbere.
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Tabuľka 2: Porovnanie parametrov fitovania pre referenčné dáta NIST s hodnotami zı́skanými
z programov QtiPlot a Kpl, a a b sú odhadované parametre, σa a σb sú štandardné neistoty (sme-
rodajné odchýlky) odhadovaných parametrov, RSD je reziduálna štandardná odchýlka (Residual
Standard Deviation), SQ je suma štvorcov odchýlok (Sum of Squares), Chi^2/doF je redukovaná
hodnota χ2 a doF znamená Degrees of Freedom čiže n− k

NIST QtiPlot Kpl

NoInt1

a 2,074 38 2,074 38 2,074 38

σa 0,016 53 0,004 63 0,016 53

n−k=10 RSD=3,567 53 Chi^2/doF=12,727 3 chi-square=127,3

SQ=127,272 72 Chi^2=127,273

BoxBOD

a 213,809 41 213,809 53 213,809 00

σa 12,354 52 0,722 99 12,354 50

b 0,547 24 0,547 24 0,547 24

n−k=4 σb 0,104 56 0,006 12 0,104 56

RSD=17,088 07 Chi^2/doF=292,002 chi-square=1168,008 876

SQ=1 168,088 77 Chi^2=1 168,008

Pozorný čitatel’, ktorý vyskúšal program QtiPlot podl’a nášho postupu (alebo
stačı́ nazriet’ do tabul’ky 2) si isto všimne, že hodnoty štandardných neistôt, ktoré
program vypočı́ta sú rádovo rozdielne od údajov inštitútu NIST. Je to spôsobené
tým, že programQtiPlotpočı́ta redukovanú hodnotu χ2 (pozri vzt’ah 14) označenú
ako Chi^2/doF, kde doF znamená Degrees of Freedom čiže n − k a štandardná
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neistota parametra je určená podl’a vzt’ahu

σqti =

√
(cov)ii

Chiˆ2/doF
. (21)

Na WWW stránke inštitútu NIST sa však dočı́tame, že ich údaj štandardnej
neistoty parametra sa počı́ta podl’a vzt’ahu

σnist =
√

(cov)ii , (22)

kde (cov)ii je v oboch prı́padoch kovariančná matica parametrov regresie, pozri
napr. v prácach (PRESS ET AL., 1992; KUDRACIK, 1999). Pri rovnosti kovariančných
matı́c, potom súvis oboch údajov môžeme vyjadrit’ vzt’ahom

σnist = σqti
√

Chiˆ2/doF. (23)

Ked’ teda potrebujeme výsledok numerického spracovania dát regresiou prog-
ramom QtiPlot uviest’ so štandardnou neistotou hl’adaných parametrov, musı́me
tento „nedostatok“ výpočtu programu korigovat’ použitı́m vzt’ahu (23), štan-
dardná neistota parametra regresie sa uvádza v takom tvare, ako na WWW
stránke inštitútu NIST.

Mali sme možnost’ pracovat’ aj s programom Origin 6.121, ktorému sa opisovaná
verzia QtiPlot 0.8.5 svojı́mi možnost’ami a ponukou najviac približuje. Čo sa týka
rozdielu z pohl’adu bežného použı́vatel’a, QtiPlot má menšı́ výber formátov do

21Komerčný program, cena aktuálnej verzie Origin 7.5 je asi 19 000,– SKK bez DPH.
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grafického výstupu. Nepokladáme to ale za taký vel’ký nedostatok. Origin 6.1
má však lepšie vypracované možnosti napr. ponuky Analysis v grafickom móde
a rozšı́renejšiu ponuku modulu Non-Linear Curve Fit. . . , lepšiu 3D grafiku a iné,
ktoré nám však pri štandardnej práci s programom nebudú chýbat’. Ako sme
už spomenuli, QtiPlot je vo vývoji a neustále sa vylepšuje. V prı́pade uvádzania
štandardných neistôt parametrov regresie program Origin ich uvádza v takej
forme, ako inštitút NIST. Tento rozdiel medzi programami je snád’ jediný vážny
nedostatok, s ktorým sme sa počas práce s programom QtiPlot stretli.

Záverom ešte jeden postreh, zo skúsenosti odporúčame otvárat’ uložené projekty
programu Kpl klikom22 na súbor s prı́ponou plo. Pri otváranı́ projektu cez hlavné
menu File→ Open Plot File . . . sa grafy v niektorých prı́padoch nezobrazia presne
tak, ako boli uložené (trochu sa posunú vložené texty, legendy a pod.). Tieto ne-
dostatky sú sı́ce formálneho charakteru, lebo graf l’ahko upravı́te do pôvodneho
stavu (ak si ho ešte s odstupom času pamätáte :-), ale dokážu zneprı́jemnit’ pôži-
tok z už vykonanej práce.

Učenie a bádatel’ská práca je zaujı́mavá, často aj vzrušujúca činnost’. Ked’ ju vy-
konávame deň čo deň tvorivo s láskou aj ako zál’ubu, prináša nám osobnú radost’
i duševné uspokojenie. Nevyhneme sa však pritom ani rutinnej a mechanickej
práci, ktorú môže počı́tač v značnej miere ul’ahčit’.

22Alebo dvojklikom, podl’a distribúcie a grafického prostredia OS GNU/Linux.
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